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Abstract
The use of high volume hydraulic fracturing (HVHF) has grown substantially in the past
decade, and with it the number of heavy duty diesel trucks (HDDTs) used to transport HVHF
materials and wastes. This research is a pilot study for the third phase of a three-phase project to
determine the potential negative health effects caused by these HDDTs. This pilot study
developed the methodology of modeling health effects, subsequent costs, and their spatial
distribution with the Environmental Protection Agency’s Environmental Benefits Mapping and
Analysis Program – Community Edition (BenMAP-CE), using data from previous phases of the
project and focusing on the effects of fine particulate matter (PM2.5) emissions in and around
Pittsburgh, PA. Health endpoints modeled include adult mortality, infant mortality, respiratory
hospital admissions, and cardiovascular hospital admissions. Other emissions datasets modeled
for comparison are: the Pennsylvania HDDT fleet of 2008, the Pennsylvania HDDT fleet
upgraded to model year 2007 emissions regulations, and ambient PM2.5 pollution. PM2.5
emissions from HVHF HDDTs have a low impact compared to the other emissions datasets and
caused less than 1 incidence for each health endpoint per 1 million people in the respective age
groups. These findings are likely suppressed due to data estimation and averaging in this and
previous phases. However, the HVHF HDDTs impact different communities than typical HDDT
traffic due to different routes and the more rural nature of HVHF activity. This model also
showed that emissions regulations can have a large positive impact on reducing health impacts.
This thesis successfully developed methodology involving BenMAP-CE as a modeling tool,
which can be used in future studies to help quantify the health impacts of emissions from HVHFrelated activity.
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Introduction
Overview of High Volume Hydraulic Fracturing
Unconventional natural gas development in the northeastern United States has grown
substantially in the past decade with the use of hydraulic fracturing and horizontal drilling
(Abdalla et al., 2012). The Marcellus Shale formation in and around Pennsylvania, Ohio, New
York, and West Virginia is one of the largest natural gas deposits in the United States (Figure 1),
with roughly 50 trillion cubic feet of proven natural gas reserves in Pennsylvania alone as of
2013 (US EIA, 2014). This resource remained largely unexploited until 2007, when horizontal
drilling and hydraulic fracturing technologies allowed its development (Abdalla et al., 2012).
The development of this resource grew quickly and by 2011 there were a total of 4,822
unconventional wells (PA DEP, 2016a). 2011 has also been the most active year to date, with
3,561 permits issued and 1,957 unconventional wells drilled, 1,757 of which were horizontal
wells (PA DEP, 2016b) (Figure 2).

Figure 1. The image on the left shows shale gas and oil plays in the United States. Note the Marcellus, outlined in
blue, in the Northeast of the United States. The image on the right shows the location of the Marcellus Shale relative
to Pennsylvania. (Both Images are from US EIA, 2011).
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Figure 2. This figure shows the growth of unconventional natural gas development in Pennsylvania. The graph
shows the number of wells drilled (black bars) (PA DEP, 2016b) and permits issued (gray bars) (PA DEP, 2016c) in
each year. Data were collected from Pennsylvania Department of Environmental Protection's oil and gas reports
(PA DEP, 2016c).

Clark et al. (2013) explains that producing natural gas from shale formations like the
Marcellus Shale involves a many step process that includes “road and well pad construction,
drilling the well, casing, perforating, hydraulic fracturing, completion, production, abandonment,
and reclamation” all of which have potential environmental impacts. A well pad is a prepared
area on the surface that provides a stable base for the wellhead, drilling and other equipment,
retention ponds, storage tanks, and loading areas for trucks. Preparing a pad requires the clearing
and leveling of several acres of land and disturbing another three or four acres for roads and
utilities (Clark et al., 2013).
Once the well pad is set up, drilling of the well begins. Shale gas formations are typically
6,000 feet or more below the surface and are between 50-200 feet thick (Clark et al., 2013). To
efficiently extract gas from these thin rock formations, a well is drilled vertically down until it is
near the shale and then a directional drill is used to gradually curve the wellbore until it follows
the shale horizontally for 5,000 feet or more (Rotman, 2009). Multiple horizontal wells can be
drilled from a single pad to maximize the area of shale that can be accessed (Clark et al., 2013).
2

At certain stages in the drilling process, drilling is stopped and steel casing and cement is
installed around the wellbore to protect the freshwater aquifer from contamination and to prevent
the leakage and escape of natural gas (Clark et al., 2013). The casing around the horizontal
section of the well is then perforated with small explosives, enabling the flow of hydraulic
fracturing fluids out of the well and into the shale formation, and the subsequent flow of natural
gas out of the shale and into the well (Clark et al., 2013). Figure 3 shows a cross section of a
typical horizontal and hydraulically fractured well.

Figure 3. Cross section showing the configuration of a typical shale gas well that has been horizontally drilled and
hydraulically fractured (Clark et al., 2013). Used with permission from Argonne National Laboratory, managed and
operated by UChicago Argonne, LLC, for the U.S. Department of Energy under Contract No. DE-AC0206CH11357.

Natural gas shale formations are unlike conventional natural gas-containing rock
formations because, unlike other rock formations, shale has low permeability and holds the
natural gas in unconnected pores and fractures (Clark et al., 2013; King, 2015). Hydraulic
fracturing is the process that fractures the shale formation, releasing the natural gas that was
3

trapped in the rock by pumping several million gallons of hydraulic fracturing fluid into the well
under very high pressure (Clark et al., 2013). Hydraulic fracturing fluid is composed of about 9899.5% water and proppant (usually sand) and 0.5-2% proprietary blend of chemicals that
enhances the fracking fluid’s properties (US DOE, 2009). Each well is hydraulically fractured in
multiple stages as only about 1,000 feet of the wellbore is hydraulically fractured at a time (Clark
et al., 2013).
After the pressure is released, fluids consisting of a combination of hydraulic fracturing
fluids, flowback water, and brine already present in the shale formation (produced water, the
largest part of the hydraulic fracturing waste stream), flows back to the surface through the well
(Adgate et al., 2014; Clark et al., 2013). Once collected, the flowback and produced water is
often reused in the subsequent stages of hydraulic fracturing, is disposed of in injection wells, or
is taken to industrial treatment plants. In the past, wastewater was sometimes disposed of in
surface water or ill-equipped wastewater treatment plants (Clark et al., 2013). Natural gas also
comes to the surface through the well along with flowback and produced water, where it is
collected and sent into pipelines to compressor stations for processing (Clark et al., 2013,
Litovitz et al., 2013).
The production lifetime of shale gas wells has not yet been fully established, but it has
been observed that their production declines more quickly than conventional natural gas wells
(Clark et al., 2013). After a well no longer produces enough gas, the wellhead is removed and the
well is filled with cement to prevent gas leakage. The surface is then reclaimed and the site is
abandoned to whoever holds the land’s surface rights (Clark et al., 2013).
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Heavy Duty Diesel Trucks
Heavy Duty Diesel Trucks (HDDTs) are required at many stages of unconventional
natural gas production to transport equipment, materials, and wastes. This research focuses
specifically on the HDDTs that transport water, sand, and wastewater for the hydraulic fracturing
stage of unconventional natural gas production as seen in numbers 2 and 8 in Figure 4.

Figure 4. Major activities during the horizontal drilling and hydraulic fracturing stages of unconventional natural
gas production. Heavy Duty Diesel Trucks (HDDTs) play a major role by transporting large volumes of water and
other supplies to the well pad and transporting wastewater from the well to disposal sites (Litovitz et al., 2013). This
image was originally published under a CC BY license (http://creativecommons.org/licenses/by/3.0/).

While the data on the exact numbers and routes of HDDTs used to transport these
materials are not publicly available, they can be estimated with network analyses using
Geographic Information Systems (GIS) software. These network analyses can generate probable
routes from origin to destination points and HDDT counts can be estimated using probable loads
and HDDT carrying capacity (Korfmacher et al., 2015).
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Most of the water needed to drill and hydraulically fracture a well is delivered by HDDT
because most local water sources are not able to provide the 100,000 gallons of water needed to
drill a well and the 3-8 million gallons of water within a week that are needed for each fracturing
event (Abdalla et al., 2012; NYC DEP, 2016), with an average of 5 million gallons needed per
fracturing event per well (NYSDEC, 2011). Assuming that all HDDTs used in the transportation
of water are 22-ton trucks with a capacity of 5,500 gallons, each fracturing event would require
909 one-way deliveries of water (Korfmacher et al., 2015).
Sand is transported by train and ship to delivery sites where it is picked up by HDDTs
and transported to well sites (Korfmacher et al., 2015). Hydraulic fracturing wells use an average
of 2,500 tons of sand per well, which requires 113 one-way trips of 22 ton HDDTs to deliver
sand to each well (Korfmacher et al., 2015). This comes to a total of 1,022 one-way trips to
deliver water and sand to one well (Korfmacher et al., 2015).
Flowback and produced water from the well is recovered as wastewater. While some of
this wastewater is stored on site in holding ponds or reused for future fracking events, some of it
is transported off-site to treatment facilities or injection wells (Korfmacher et al., 2015). The
Pennsylvania Department of Environmental Protection maintains a waste database with origin
and destination information, the amount of waste shipped, and other information. However, this
information is voluntarily provided by hydraulic fracturing companies and is therefore likely
incomplete, making it difficult to estimate the total amount of wastewater being transported by
HDDTs (Korfmacher et al., 2015).
In all, Korfmacher et al. (2015) estimate that nearly 2 million one-way HDDT trips were
required to bring sand and water to and waste from the 1,757 horizontal wells that were drilled in
2011 in Pennsylvania, assuming that all HDDTs had a carrying capacity of 22 tons (Table 1).
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Using the Geospatial Intermodal Freight Transport (GIFT) model (Winebrake et al., 2008),
which is an ArcGIS extension that integrates with Network Analyst, Korfmacher et al. (2015)
calculated HDDT routes with HDDT count estimates using Origin and Destination pairs (Figure
5). They also calculated preliminary emissions estimates for particulate matter (PM) and other
pollutants along the road segments of these HDDT routes (Table 1, Figure 6). Figure 6 shows
emissions hotspots generated by these HDDTs where people living in these locations are likely at
a higher risk of health impacts caused by these emissions.

Table 1. “Estimated truck counts by variable loads and associated emission totals for the delivery of sand and water
and the removal of waste materials to and from PA wells in 2011. Miles and hours represent total vehicle miles and
hours for one way trips, trucks represent number of truck trips” (Korfmacher et al., 2015).

Figure 5. Estimated one-way truck counts for 22 ton trucks carrying sand, water, and waste to and from wells
drilled in 2011. (Korfmacher et al., 2015).
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Figure 6. Estimated PM10 emissions (g/mile) from 22 ton trucks transporting sand, water, and waste one-way in
2011 (Korfmacher et al., 2015).

Particulate Matter Emissions
Heavy Duty Diesel Trucks (HDDTs) emit a variety of pollutants that can have negative
impacts on human health and the environment (Adgate, 2014; McKenzie et al., 2012). These
pollutants include the greenhouse gas carbon dioxide (CO2), as well as other dangerous
compounds like carbon monoxide (CO), volatile organic compounds (VOC), nitrogen oxides
(NOx), sulfur oxides (SOx), and particulate matter (PM) (US EPA, 2008).
Particulate matter (PM) is a type of air pollution that can come from both natural and manmade sources and is made up of particles of solids or liquids suspended in the air (US EPA,
2016a). PM is defined by its size and is not made up of any one type of chemical or material.
Coarse particulate matter is any particle of 10 micrometers (microns) or less in diameter (PM10),
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and fine particulate matter is any particle of 2.5 microns or less in diameter (PM2.5) (US EPA,
2016a). PM is also categorized as primary or secondary depending on how it was created.
Primary particles, which are typically in the coarse size class (PM10), are emitted directly
from sources that can include fires, road dust, agriculture, fuel combustion, mobile sources,
industrial processes, and wear of vehicle parts (Lee, et al., 2012; US EPA, 2016a). Coarse
particulate matter can contain organic and elemental carbon; metals such as iron, silica, and
aluminum; base cations from soil; small biological materials such as pollen, fungal spores,
bacteria, and fragments of plants and insects; as well as fly ash, automobile tire fragments, and
brake linings (Grantz, et al., 2003).
Secondary particles, on the other hand, which are typically in the fine size class (PM2.5),
are formed in atmospheric reactions from chemicals like sulfur dioxides and nitrogen oxides that
were emitted from sources like vehicles, industries, and power plants. These secondary reactions
are dependent upon meteorology, especially temperature, and baseline levels and composition of
ambient PM2.5 (Fann, et al., 2009; and US EPA, 2016a).
This project focuses on primary PM that is emitted from HDDTs. Particulate matter
emissions from diesel engines tend to be a mixture of elemental carbon, hydrocarbons, sulfur
compounds, and other species (Burtscher, 2005). The average HDDT in use in 2008 emitted
0.219 g/mile (or 136 µg/m) of PM10, 92% of which is in the PM2.5 size class (US EPA, 2008).
The United States Environmental Protection Agency (US EPA) sets National Ambient
Air Quality Standards (NAAQS) for six common pollutants including particulate matter (US
EPA, 2016a). In 2006 the standard for annual average PM2.5 was 15 micrograms per cubic meter
(µg/m3), the standard for 24-hour PM2.5 was 35 µg/m3, and the 24-hour PM10 standard was 150
µg/m3 (US EPA, 2006). In 2012 the annual PM2.5 standard became more stringent and was
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updated to 12 µg/m3 (US EPA, 2012). The EPA revoked the annual PM10 standard in 2006 due
to lack of evidence linking health problems to long-term exposure to inhaled coarse particulate
matter larger than PM2.5 (US EPA, 2006).

Human Health Impacts of PM
Of the six common air pollutants, for which the United States Environmental Protection
Agency (U.S. EPA) sets National Ambient Air Quality Standards (NAAQS), particulate matter
(PM) pollution poses one of the greatest health risks (US EPA, 2016a). Exposure to PM
pollution is linked to a variety of significant health problems, which can include respiratory and
cardiovascular diseases, and premature death (US EPA, 2006).
When inhaled, the particles in PM pollution can reach the deepest parts of the lungs (US
EPA, 2006), depending on their size fraction (Pražnikar & Pražnikar, 2012). Most of the coarse
PM fraction are deposited in the upper respiratory tract in the nasal, pharyngeal, and laryngeal
areas. Fine PM can travel much deeper into the lungs and deposit in the alveolar ducts and sacs
and can be especially toxic (Pražnikar & Pražnikar, 2012) (Figure 7). The inhaled particles are
then processed primarily by the alveolar macrophages and lung epithelial cells. These cells
produce pro-inflammatory mediators that can trigger both a local inflammatory response in the
lungs as well as a systemic inflammatory response (Pražnikar & Pražnikar, 2012).
Once in the lungs, PM can also instigate extrapulmonary effects on the cardiovascular
system through three different pathways (Figure 8). In one pathway PM can trigger the release of
proinflammatory mediators or vasculoactive molecules from lung cells. In another pathway the
interactions between particles and lung receptors or nerves can cause a perturbation of systemic
autonomic nervous system balance or heart rhythm. In the third pathway PM or constituents of
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PM, such as organic compounds and metals, can be transported into the blood stream (Brook et
al., 2010).

Figure 7. Deposition of PM in the respiratory system. Most of the PM10 is deposited in the nasal, pharyngeal, and
laryngeal regions. PM5 is deposited in the trachea. PM2.5-0.1 are deposited deep in the lungs in the alveolar ducts
and sacs (Pražnikar & Pražnikar, 2012)Image used with permission of the authors.

Figure 8. “Biological pathways linking PM exposure with CVDs. The 3 generalized intermediary pathways and the
subsequent specific biological responses that could be capable of instigating cardiovascular events are shown. MPO
indicates myeloperoxidase; PAI, plasminogen activator inhibitor; PSNS, parasympathetic nervous system; SNS,
sympathetic nervous system; and WBCs, white blood cells; A question mark (?) indicates a pathway/mechanism with
weak or mixed evidence or a mechanism of likely yet primarily theoretical existence based on the literature” (Brook
et al., 2010). Image used with permission from the American Heart Association.
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Particulate matter can have different health effects depending on its size class and the
amount of time someone has been exposed to it. Short-term exposure to PM2.5 over the span of a
few hours to days can result in respiratory and cardiovascular-related mortality and morbidity.
Respiratory-related symptoms can include coughing, wheezing, and shortness of breath; lung
function changes in children and people with lung diseases like asthma; increased hospital,
emergency room, and doctor’s visits for respiratory diseases; and even premature death in people
with lung disease (US EPA, 2006). Cardiovascular-related symptoms can include changes in
heart rate variability and arrhythmia; myocardial ischemia; heart attacks; heart failure; stroke;
increased hospital admission and ER visits for cardiovascular diseases; and cardiovascular
disease related mortality (Brook et al., 2010; US EPA, 2006). Susceptible, but not necessarily
critically ill individuals, are at increased risk for cardiovascular morbidity and mortality when
exposed to short term PM2.5. Susceptible individuals may include the elderly and people with a
history of coronary artery disease. Women, obese individuals, or those with diabetes might also
be more susceptible to PM exposure (Brook et al., 2010).
Long-term exposure to PM2.5 can lead to reduced lung function and chronic respiratory
disease in children (US EPA, 2006). It can also lead to premature death in susceptible people
with a history of heart and lung diseases. Causes of death can include lung cancer (US EPA,
2006) and cardiovascular events (Brook et al., 2010). Long-term exposure to elevated levels of
ambient PM2.5, such as an increase of 10 µg/m3, can lead to several months to a few years’
reduction of life expectancy within a population (Brook et al., 2010). Not as much is known
about the effects of long-term PM2.5 exposure on nonfatal health events (Brook et al., 2010).
The EPA sets NAAQS for PM and other pollutants to protect public health. However,
multiple studies and reviews have found that there does not appear to be a “safe” threshold below
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which PM no longer has negative health effects. The PM2.5 concentration-risk relationship does
not appear to decrease and extends below the 15 µg/m3 annual NAAQS level set in 2006 (Brook
et al., 2010; Currie et al., 2011; and Englert, 2004).

Particulate Matter Emissions Dispersal Modeling
The dispersal and concentration of Particulate Matter (PM2.5 and PM10) emissions can be
estimated using both monitoring systems and modeling software. Each method has its own pros
and cons. Monitoring stations are able to measure the actual amount of pollutant that is in the air
on a continuous basis, providing information on hourly, daily, and seasonal variability in relation
to weather, terrain, and activity patterns. But they have a number of limitations. Monitoring
stations are primarily located in urban areas, with very few located in rural regions, where the
majority of the High Volume Hydraulic Fracturing (HVHF) sites are located (Figure 9). They
may also be placed close to major roadways or industrial areas that may not be close to
residential areas so their measurements may not be representative of community-level exposure
to the pollutant (Bell, 2006). Air pollution is difficult to track and concentrations can vary widely
in an area (Currie et al., 2011). Additionally, some monitoring stations only monitor PM10 every
6 days instead of every day, and detailed information on the chemical composition of PM is only
available in a limited number of locations (Bell, 2006).
Emissions modeling addresses many of these problems, but also has its own limitations.
Modeling allows air quality to be estimated in rural locations and other areas where there are no
monitoring stations, and can estimate daily and even hourly air quality, thus increasing the
spatial and temporal resolution (Bell, 2006). Modeling can also estimate the dispersion and
concentrations of emissions from one specific source, such as certain trucks, or a specific HVHF
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well, while monitoring sites typically cannot. Modeling, however, relies on many assumptions
and model estimates should be validated to make sure they appropriately represent ambient
concentrations (Bell, 2006).

Figure 9. EPA monitoring stations for PM2.5. Note that most stations are in the south west and south east portions of
the state near major metropolitan areas like Pittsburgh and Philadelphia. Very few stations are in the rural
Marcellus Shale area where most of the High Volume Hydraulic Fracturing activity takes place. The station in the
North East part of PA did not become active until 2014.

Korfmacher et al. (2016) modeled the emissions concentration and dispersal of PM from
Heavy Duty Diesel Trucks (HDDTs) involved in the transport of materials and waste for High
Volume Hydraulic Fracturing (HVHF) using the AERMOD pollution dispersion model (US
EPA, 2016b). Road segments with the highest estimated traffic (>25,000 trucks), as identified by
the network analysis (Korfmacher et al., 2015), were used to select USGS quadsheets as areas of
14

interest for emission dispersal analysis with AERMOD (Korfmacher et al., 2016). Four sets of
simulations were modeled for the year 2011 using GIFT road networks of HDDT traffic involved
in HVHF (Korfmacher et al., 2015) and Pennsylvania Department of Transportation (PADOT)
road networks for all HDDT traffic. Each road network was analyzed twice using either the US
EPA’s average PM10 emission rate for Heavy Duty Diesel Engines in use during 2008, or the
more stringent PM10 emission rate required for Model Year 2007 Heavy Duty Diesel Engines
(Korfmacher et al., 2016). These four sets model the emissions of HDDTs from the PADOT road
network with average 2008 emissions rates (PA2008), HDDTs from the PADOT road network
with Model Year 2007 emission rates (PA2007), HDDTs from the GIFT road network with
average 2008 emission rates (GIFT2008), and HDDTs from the GIFT road network with Model
Year 2007 emission rates (GIFT2007).
The AERMOD analyses showed that the highest modeled emission concentration in a
polygon was 2.845 µg/m3 for the PADOT road networks (in PA2008) and 0.082 µg/m3 for the
GIFT road networks (in GIFT2008), where the major difference in emissions concentration is
primarily due to the difference in overall truck count between the two road networks
(Korfmacher et al., 2016). PADOT road network emissions were highest around major cities and
major highways. GIFT road network emissions were highest along major roadways, but also in
smaller towns and rural roads that are close to Hydraulic Fracturing wells (Korfmacher et al.,
2016). Figures 10 through 13 show the AERMOD results.
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Figure 10. AERMOD results for PA2008. Emission concentrations (µg/m3) of HDDTs included in PADOT road
networks. Emissions are based on US EPA’s Average In-Use Heavy Duty Diesel Emission Rates of PM10 in 2008
(0.219 g/mile) (Korfmacher et al., 2016).

Figure 11. AERMOD results for PA2007. Emission concentrations (µg/m3) of HDDTs included in PADOT road
networks. Emissions are based on Model Year 2007 emissions rates of PM10 (0.036 g/mile) (Korfmacher et al.,
2016).
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Figure 12. AERMOD results for GIFT2008. Emission concentrations (µg/m3) of HDDTs involved in Hydraulic
Fracturing as estimated by the GIFT model. Emissions are based on US EPA’s Average In-Use Heavy Duty Diesel
Emission Rates of PM10 in 2008 (0.219 g/mile) (Korfmacher et al., 2016).

Figure 13. AERMOD results for GIFT2007. Emission concentrations (µg/m3) of HDDTs involved in Hydraulic
Fracturing as estimated by the GIFT model. Emissions are based on Model Year 2007 emissions rates of PM 10
(0.036 g/mile) (Korfmacher et al., 2016).
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Health Impacts and Costs Modeling (BenMAP-CE)
Once emissions concentration and dispersal is known, human health impacts and costs
can be modeled. Environmental Benefits Mapping and Analysis Program – Community Edition
(BenMAP-CE), was developed by the U.S. Environmental Protection Agency (U.S. EPA) as an
open-source and user-friendly alternative to BenMAP (US EPA, 2015a). BenMAP-CE is a health
impact model with an integrated geographic information system (GIS) that is a powerful and
easy to use Windows-based computer program with tools for both novice and advanced users
(US EPA, 2015a).
BenMAP-CE can estimate the number of health impacts from changes in air quality as
well as the costs associated with these impacts (Fann et al., 2009; US EPA, 2015a). The program
can estimate both the human health and economic benefits associated with air quality
improvement policies as well as the health burdens and economic costs associated with air
pollution levels (US EPA, 2015A). Some examples include changes in the risk of premature
death, heart attacks, and other adverse health effects and the monetary costs or benefits
associated with those health impact changes (US EPA, 2015A). These estimates are calculated
using data from peer-reviewed epidemiological and economic studies. BenMAP-CE then uses a
GIS to create and export maps that visualize the results of the analysis as well as other data
including air pollution and population (US EPA, 2015A).

Assessing at the Local and Regional Scale
According to Fann et al. (2009) there are several factors that strongly influence the
human health costs/benefits of a change in ambient fine particulate matter. These include
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atmospheric conditions, characteristics of the emitting source, geographic location, and
population density.
Local and regional weather patterns determine where PM emissions are transported and if
they will be transported to population centers (Fann et al., 2009). As an example of the transport
of emissions, Vinciguerra, et al. (2015) found that there was an increased concentration of ethane
in certain cities that was most likely caused by emissions from hydraulic fracturing sites in the
Marcellus Shale being blown hundreds of kilometers downwind. They hypothesize that other
pollutants, like ozone and PM, are likely also transported over long distances at increasing rates
due to the increase in hydraulic fracturing. In this research, AERMOD accounted for the effects
of local and regional weather by using historical weather data to determine the dispersal and
concentration of PM from HDDT traffic (Korfmacher et al., 2016).
The potential for transport from an emission source to a population center also depends
on the characteristics of the source such as height of emission release and velocity of emissions
(Fann et al., 2009). Our AERMOD analyses also accounted for this factor by including HDDT
dimensions and exhaust plume dimensions (Korfmacher et al., 2016).
Finally, the geographic location of an emission source and the density of the population
nearby is another factor in the human health cost/benefit of a change in the concentration of
ambient PM2.5. A larger population is more likely to have a higher cost/benefit per unit of
emissions because there are likely more people with a history of health problems that would
make them more susceptible to adverse health outcomes. Likewise, an emission source closer to
a large population is likely to have a higher cost/benefit per unit of emissions because it will
have a more direct impact on that population than an emission source that is farther away (Fann
et al., 2009).
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This thesis focused on an area around Pittsburgh, PA (AOI 3 in Figures 10-13) for the
reasons that Fann, et al. (2009) describe. Pittsburgh is a metropolitan area with a large
population. There is also a high density of hydraulic fracturing activity and associated HDDT
traffic nearby. Although hydraulic fracturing and associated HDDT traffic are present throughout
a large area of Pennsylvania, much of it rural, it is better to focus on a heavily populated
metropolitan area for this pilot study where there is likely to be a higher health and economic
cost/benefit per unit emission change than in a rural area. Additionally, there are a greater
concentration of air quality monitors in the Pittsburgh area than in the rural areas. The presence
of these monitors provide a more accurate baseline for ambient PM.

Purpose
The purpose of this pilot study was to develop a methodology using BenMAP-CE to
model the health impacts and related costs of the PM emissions of HDDTs that were modeled in
an earlier phase of this project. This methodology is also meant as a foundation for future
research in this project.
Additionally, I compared the effects of HVHF-related HDDT traffic to the effects of all
PA HDDT traffic in 2011, the busiest year for HVHF. I also compared the effects of emissions
from the average HDDT fleet in use in 2008 to the lower emissions of a hypothetical HDDT fleet
that had been updated to the more stringent 2007 emissions standards.
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Methods
BenMAP-CE Overview
BenMAP-CE (US EPA, 2015a) uses the following process, as illustrated in Figure 14, to
estimate human health effects and the monetary costs/benefits of these effects based on a change
in air quality. In Step 1, BenMAP-CE calculates the change in air quality (Delta) between the
ambient air quality (Baseline), and the air quality after a change in emissions (Control). These air
quality data can be generated from modeling or monitoring data. The program does have some
pre-loaded monitoring data available up to the year 2008 (US EPA, 2015a). This project input air
quality data for 2011 using the results of previous phases of this study. BenMAP-CE then uses
the values from the Delta in the next step. In Step 2, BenMAP-CE applies the relationship
between the change in pollution and certain health effects, which is also known as the Health
Impact Function (HIF). This function is derived from epidemiological studies in the literature.
The HIF is applied to calculate the health impacts on the exposed population (US EPA, 2015a).
Finally, in Step 3, BenMAP-CE calculates the economic value of the health effect derived in
Step 2 using valuation functions (US EPA, 2015a).

Figure 14. BenMAP Analysis: Inputs and Outputs. This figure shows a flow diagram of the steps in BenMAP-CE
(US EPA, 2015a).
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Data Preparation
AERMOD Re-Run
In the previous phase of this project, the emissions concentration and dispersal of four
sets of HDDT traffic (GIFT2007, GIFT2008, PA2007, and PA2008) were modeled in AERMOD
based on USGS quadsheets (Korfmacher et al., 2016). These AERMOD emissions dispersal
models were re-run to match the 12 km CMAQ (Community Multi-scale Air Quality) ambient
air pollution grid that is available in BenMAP-CE. The CMAQ grid is also used for emissions
monitoring data and population data in BenMAP-CE.
To re-run the AERMOD models, the CMAQ grid was exported from BenMAP-CE and
opened in ArcGIS. In ArcGIS, the GIFT (2007 and 2008) and PA (2007 and 2008) road
networks (Korfmacher et al., 2015) were each intersected with the 12 km CMAQ grid. This
applied the CMAQ grid cell ID to the road segments within that cell. The road segments of each
CMAQ cell were then exported to a new shapefile where the line data were converted to point
data. The point data are the vertices that make up the road segments. Latitude and Longitude
information was added to these points to create XY point pairs. These XY points were then
added to a specially formatted excel sheet that also included total HDDT PM10 emissions for
each road segment, as well as other important information needed for the AERMOD model
(Korfmacher et al., 2016). An example of the excel sheet setup is shown in Table 2. These excel
sheets were imported independently into AERMOD and modeled separately. AERMOD then
modelled the emissions concentration and dispersal of each of the cells and created shapefiles of
the results.
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According to HDDT emissions data from the EPA, 92% of PM10 is actually in the PM2.5
size class (US EPA, 2008). Therefore, the PM10 emissions dispersal data from AERMOD will be
treated as if it is PM2.5 from here on.
Table 2. AERMOD Excel sheet format.

Note. This table shows the format of the excel sheet that is entered into AERMOD. It contains information on each
road segment including its ID, the height of the HDDT, emissions rate, plume dimensions, number of coordinates in
the road segment, and the corresponding XY point pairs (Korfmacher et al., 2016).

Process AERMOD Results
The shapefiles produced by AERMOD are slightly larger than their respective CMAQ
cells and need to be clipped down in ArcGIS (Raw AERMOD Shapefiles in Figure 15).
Additionally, resulting emissions concentrations from AERMOD can be complex and nonuniform with multiple polygons within the CMAQ cell (Clipped AERMOD Shapefiles in Figure
15). I calculated the area weighted average emissions concentration for each clipped AERMOD
shapefile, so that there was one PM2.5 value per CMAQ cell (Area Weighted Average Emissions
in Figure 15). This way, the resolution of the modeled emissions would match the resolution of
the monitored ambient PM2.5 emissions. Finally, all of the CMAQ cells were merged to form the
emission shapefiles (GIFT2008, PA2007, and PA2008).
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Figure 15. This figure shows the three main steps in processing the AERMOD results, going from left to right, and
top to bottom. The raw AERMOD shapefiles are slightly bigger than, and tilted in relation to, the CMAQ grid. The
raw shapefiles are clipped to the boundary of their respective CMAQ cell (they were only merged in this example to
show the raw emissions in relation to each other). Finally, the area weighted average is calculated for each CMAQ
cell, then all cells are merged together.

Figure 16 shows the results of the AERMOD models for each of the GIFT and PA sets
after being clipped to the CMAQ grid and merged together. The lines of higher emissions
correspond to the road networks. GIFT2007 has clearly lower emissions than the other sets
(nearly zero) and was not included in the rest of the study. The emissions concentrations in
GIFT2007 are roughly an order of magnitude lower than the next lowest emissions
concentrations of GIFT2008. Since the resulting health incidences and valuations for GIFT2008
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were very low compared to the PA emissions sets, GIFT2007’s health incidences and valuations
would be very close to zero.

Figure 16. AERMOD results showing emissions dispersal and concentration of PM 2.5 in µg/m3. Lines of higher
concentrations correspond to road networks.

Create Inputs for Air Quality Surface
In the first step of BenMAP-CE, the program uses Baseline air quality data and Control
air quality data to calculate the change between the two (Delta). The program is set up in such a
way that it assumes the Delta is unknown by its users. It also assumes that the Control, or the air
quality after a change in emissions, will have less pollution than the original Baseline air quality.
The Delta does not calculate properly if the Control is greater than the Baseline. So the Delta it
calculates is the amount emissions decreased. Later steps in BenMAP-CE calculate the health
25

impacts of this Delta, which is interpreted as the number of lives saved or the amount by which
other health impacts are decreased due to the reduction in emissions.
This study, however, uses BenMAP differently. The target emissions that health effects
will be calculated for are already known. These are the HDDT emissions calculated with
AERMOD. These values have to be the Delta in order for BenMAP-CE to calculate the health
effects due to that subset of emissions. The health impacts will be interpreted as the number of
deaths and other health impacts caused by the HDDT emissions.
In order for the Delta to be the same as the HDDT emissions set of interest, I had to make
sure the Baseline and Controls were set up properly. 2011 ambient PM2.5 air quality monitoring
data was used for the Baseline. I assumed that HDDT emissions were already included in the
monitoring data. For the Control, I subtracted the pre-calculated HDDT emissions from the
Baseline. This results in a Delta equal to the HDDT emissions.
1. Delta = Baseline – Control
2. Delta = Baseline – (Baseline – HDDT)
3. Delta = HDDT


GIFT2008
o Baseline = 2011 ambient PM2.5 air quality monitoring data
o Control = Baseline – GIFT2008 area weighted average PM2.5 emissions
o Delta = GIFT2008 area weighted average PM2.5 emissions



PA2007
o Baseline = 2011 ambient PM2.5 air quality monitoring data
o Control = Baseline – PA2007 area weighted average PM2.5 emissions
o Delta = PA2007 area weighted average PM2.5 emissions
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PA2008
o Baseline = 2011 ambient PM2.5 air quality monitoring data
o Control = Baseline – PA2008 area weighted average PM2.5 emissions
o Delta = PA2008 area weighted average PM2.5 emissions

I am also calculating the effects of ambient PM2.5 on human health to compare to the effects
of HDDT emissions. In this case, the Control had to be zero so that the Delta would be the same
as the baseline ambient air quality.
1. Delta = Baseline – Control
2. Delta = Baseline – 0
3. Delta = Baseline


Ambient Baseline PM2.5
o Baseline = 2011 ambient PM2.5 air quality monitoring data
o Control = 0
o Delta = 2011 ambient PM2.5 air quality monitoring data

Create Baseline

The Baseline is the ambient air quality. To create the Baseline of ambient PM2.5
concentrations, I used both BenMAP-CE and ArcGIS. I exported the CMAQ and States grid
definitions from BenMAP-CE, then opened them in ArcGIS. In ArcGIS I used the States grid to
clip the CMAQ grid down to the states that contain the Marcellus Shale formation (Maryland,
New York, Ohio, Pennsylvania, and West Virginia) to create a Marcellus Shale CMAQ grid.
Then in BenMAP-CE, I created a new setup to which I added Grid Definitions,
Pollutants, and Monitor datasets. I used the Marcellus Shale CMAQ shapefile as the grid
definition. The PM2.5 pollutants dataset is set up as a daily observation type, with a 24-hour mean
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as the metric. The seasonal metrics for the pollutants were set up as an annual average. This
PM2.5 dataset is also used in later steps.
BenMAP-CE includes air quality monitoring data up to 2008, but this project focused on
air quality in 2011. Monitoring data for 2011 were downloaded from the US EPA (2016c) and
set up in an excel document. Figure 17 shows the correct format for the excel sheet. This excel
sheet was then added to the Monitoring Datasets section of the BenMAP-CE setup.

Figure 17. This figure shows the correct format for daily monitoring data. The columns from left to right are:
Monitor Name, Monitor Description, Latitude, Longitude, Metric, Seasonal Metric, Statistics, and Values. The
Values column includes monitoring data values from every day in 2011. Daily values are separated by commas and
days with no data are represented by a period. The BenMAP-CE user manual has a detailed description of how to
set up the excel sheet (US EPA, 2015a).

After completing the setup, I used BenMAP-CE to create a map of PM2.5 concentrations
in the Marcellus Shale area. In the main BenMAP-CE window I selected PM2.5 as the pollutant.
In the Air Quality Baseline tool, I used the 2011 monitor dataset and the Marcellus CMAQ grid
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definition, in conjunction with the Voronoi Neighborhood Averaging interpolation method.
Voronoi Neighborhood Averaging allows BenMAP-CE to take PM2.5 concentration data from
the monitoring station point sources that surround the center of each grid cell and calculate an
inverse-distance weighted average for that cell. Results are shown in Figure 18.

Figure 18. This figure shows the BenMAP-CE program and the resulting map of emissions concentrations using
Voronoi Neighborhood Averaging with 2011 PM2.5 air quality monitoring data in the Marcellus Shale area.

Next, I imported the Marcellus Shale ambient emissions shapefile that was created in
BenMAP-CE into ArcGIS where I clipped it down to the CMAQ grid of the AERMOD
modeling data. The resulting shapefile serves as the Baseline PM2.5 emissions for this research
(Figure 19). This shapefile’s attribute table was exported and imported into Excel where it was
put into the correct format for input in BenMAP-CE (Figure 20).
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Figure 19. This figure shows the ambient PM2.5 in 2011 as recorded by air quality monitors and distributed across
the AOI CMAQ grid using Voronoi Neighborhood Averaging.

Figure 20. This figure shows the correct setup for annual emissions data in Excel to be input into BenMAP-CE.
Values for Column and Row are derived from the CMAQ grid. Metric, Seasonal Metric, and Annual Metric, reflect
the pollutant dataset that was created in BenMAP-CE. Values are the average yearly PM2.5 value for that CMAQ
cell.
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Create Controls

In BenMAP-CE, the Control is the air quality after a change in emissions. To create the
Controls, I used ArcGIS to subtract the emissions of each HDDT emissions dataset (GIFT2008,
PA2008, and PA2007) from the Baseline to create a unique control for each dataset. The
resulting attribute tables were exported to Excel and set up in the same format as the Baseline
excel sheet in Figure 20. I also created an Excel sheet where all the values are 0. This served as
the control for the Ambient emissions dataset where the Delta equals the Baseline.
Prepare Population Data with PopGrid
PopGrid v4.3 is a program that comes with BenMAP-CE. It takes built-in population data
and applies them to a shapefile. I used the 2010 census data in PopGrid and applied them to the
CMAQ grid of the area of interest around Pittsburgh, PA. Figure 21 shows the 2010 population
in the CMAQ grid.

Figure 21. This figure shows the results of the PopGrid v4.3 program. The 2010 population has been calculated for
each CMAQ cell in the area of interest. Total population in the AOI is 1,238,991.
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BenMAP-CE Model
New Project Setup
Each HDDT emissions set was run as its own project in BenMAP-CE, all of which used
the same setup. The setup includes grid definitions, population data, pollution data, and other
datasets. The grid definition is the CMAQ grid of the Pittsburgh, PA area. The population data
are the PopGrid data created with the 2010 census and the AOI CMAQ grid. The pollution data
are the same as the dataset that was created in the data preparation phase: PM2.5 measured daily
with a 24-hour mean metric and a yearly average for the seasonal metric. The following is a list
of datasets that were exported from the base United States setup that comes with BenMAP-CE
and imported into the setup for these projects:







Incidence/Prevalence Rates
o Mortality Incidence (2010)
o Other Incidence (2007)
Health Impact Functions
o EPA Standard Health Functions
o PM NAAQS Final 2012 Additional Functions
Variable Datasets
o EPA Standard Variables
Inflation Datasets
o EPA Standard Inflators
Valuation Functions
o EPA Standard Valuation Functions
Income Growth Adjustments
o EPA Standard Income Growth

Air Quality Surfaces
In the first step of the model, BenMAP-CE calculates the difference (Delta) in air quality
between the Baseline (ambient air quality) and the Control (air quality after a change in
emissions). After choosing PM2.5 as the pollution data, I chose the appropriate Excel files for the
Baseline and the Control, and entered them as Model data. Once the Pollutant, Baseline, and
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Control have all been input into the program, BenMAP-CE calculates the Delta. The Baseline,
Control, and Delta can all be visualized within the program (Figure 22). The Delta values for
each of the emissions sets can be seen in Figures 23 and 24. The Delta values are the same as the
original area weighted average HDDT emissions of the datasets. BenMAP-CE cannot model
impacts from just one set of emissions. There must be a Baseline and a Control, with a Delta that
it calculates itself.

Figure 22. BenMAP-CE has built-in GIS capability. In this figure, BenMAP-CE is displaying the Delta results.
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Figure 23. This figure shows the Delta results of each of the Heavy Duty Diesel Truck (HDDT) emissions sets. The
Delta values are the same as the HDDT emissions so that the health effects of the HDDT emissions can be
calculated in BenMAP-CE.

Figure 24. This figure shows the Delta results of the Ambient PM emissions sets. The Delta values are the same as
the Baseline Ambient emissions so that the health effects of the ambient emissions can be calculated in BenMAP-CE.
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Estimate Health Impacts
Once the change in air pollution has been calculated, BenMAP-CE calculates the Health
Impact Function (HIF) to determine the change in the incidence of a health endpoint on the
exposed population based on the change in the concentration of PM2.5 (Fann et al., 2009; US
EPA, 2015a). In the HIF in Figure 25, the Health Baseline Incidence (Yo) is an estimate of the
average number of people who are impacted by an adverse health effect in a particular
population over a particular period of time. The Health Effect Estimate (β) estimates the percent
change of health effect risks due to a one-unit change in air pollution. The Air Quality Change
(∆PM) is the difference (delta) between the initial ambient air pollution concentration (baseline)
and the ambient air pollution concentration after a change (control). The Exposed Population
(Pop) estimates the number of people who are exposed to the pollutant (US EPA, 2015a). A
simplified version of the equation in Figure 25 is “Health Effect = Air Quality Change *
Health Effect Estimate *Exposed Population * Health Baseline Incidence” (US EPA,
2015A).

Figure 25. This figure illustrates how BenMAP-CE derives a health impact function from the epidemiology
literature (US EPA, 2015a).
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BenMAP-CE provides a database of HIFs, which are derived from epidemiology studies
that analyze the cases of specific or general health effects. The health endpoints available in
BenMAP-CE include mortality, hospital and emergency room visits for respiratory and
cardiovascular causes, various respiratory and cardiovascular symptoms and diseases, and school
and work loss days. Fann et al. (2012) recommend being sure to assess health endpoints that do
not overlap so that impacts will not be counted more than once.
Because this is a pilot study to develop BenMAP-CE methodology and to assess the
broad health effects of a change in PM2.5 on the general population of Pittsburgh, I chose HIFs
that represent the broader cardiovascular- and respiratory-related morbidity and mortality
impacts. I chose the health endpoints of mortality, infant mortality, hospital admissions due to
chronic lung diseases, and hospital admissions due to cardiovascular diseases (less heart attacks).
These health endpoints all reflect chronic exposure to PM2.5. The EPA also primarily uses HIFs
that are based on annual mean measurements of PM2.5, and not acute exposure to PM2.5 (Ali
Kamal, personal communication, April 25, 2017). There are multiple HIFs for each health
endpoint. These can vary widely in terms of the locations and study populations that are included
in the study. Table 3 shows details of the HIFs used in this thesis.
Table 3. Health Impact Functions

Note: The Function is the formula that BenMAP-CE uses to estimate air pollution related health impacts. The
Baseline Function is the formula used by BenMAP-CE to estimate health impacts due to all causes. Beta is the mean
value of the Beta Distribution. P1Beta is the Parameter 1 of the Beta Distribution and represents the Standard
Deviation. (US EPA, 2015a).
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HIFs can be used singularly, as a range, or pooled together. When pooling HIFs, they
must first be in the same health endpoint group. The health endpoint groups that appear in this
study include: Mortality; Hospital Admissions, Respiratory; and Hospital Admissions,
Cardiovascular. Within those groups, health endpoint functions can be pooled together as long as
the age ranges overlap, and are edited to match.
The US EPA reports a range for rates of mortality, using the HIFs by Krewski, et al.
(2009) (low end of the range) and Lepeule, et al. (2012) (high end of the range). Ali Kamal, the
contact for BenMAP at the US EPA, explained that because there are so many differences
between the study populations sampled in the different mortality HIFs, it is better to report a
range for mortality from low to high instead of pooling the mortality HIFs together (personal
communication, April 25, 2017). The Krewski (ages 30-99) and Lepeule (ages 25-99) adult
mortality HIFs were run singularly and then used as opposite ends of a range. Their age ranges
did not have to be edited to match because these HIFs were not pooled.
There are only two HIFs for infant mortality available in BenMAP-CE, both by
Woodruff, et al. I only used the HIF by Woodruff, et al. (1997). This study includes a large study
population drawn from many metropolitan areas and controls for various risk factors in infants.
Although Woodruff, et al. have a more recent study in California from 2006, the US EPA
continues to use the 1997 study because of its national scale (US EPA, 2016d).
There are three HIFs in the Hospital Admissions, Respiratory endpoint group whose age
ranges span the majority of adulthood. Of these, the US EPA uses the HIF by Moolgavkar
(2000a) for hospital admissions due to chronic lung diseases not including asthma (Ali Kamal,
personal communication, May 9, 2017). This HIF has an age range of 18-64. I pooled that HIF
with Sheppard’s (2003) HIF for hospital admissions due to asthma, which has an age range of 0-
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64, to cover all types of respiratory hospital admissions. When pooling these two HIFs, the age
ranges were adjusted to 18-64.
The Hospital Admissions, Cardiovascular endpoint group had only one HIF with an age
range (18-64) that spans the majority of adulthood, all others had age ranges of 65 and over. I
used this HIF, Moolgavkar (2000b), so the results would be easier to compare to the results of
the other HIFs in this study. Moolgavkar’s (2000b) endpoint is hospital admissions due to all
cardiovascular diseases except myocardial infarction. I could not pool this HIF with HIFs for
myocardial infarctions because they were in a different health endpoint. It also could not be
pooled with HIFs of respiratory hospital admissions due to falling under different endpoint
groups, so it was run singularly.

Estimate Valuation
In the final step, BenMAP-CE calculates the cost of the health impacts. The value of the
health effect can be calculated in a few different ways. The Value of Statistical Life (VSL) is
often used to calculate the value of an avoided premature death. The VSL is the amount of
money that a community of people are willing to pay in order to slightly reduce the risk of
premature death in the population (US EPA, 2015a). Other health effects are measured by the
medical costs of the illness (US EPA, 2015a). The economic value of the health effects can be
calculated by multiplying the economic value of each case of the health effect by the change in
occurrence of the health effect. Simply, “Economic Value = Health Effect * Value of Health
Effect” (US EPA, 2015a). Figure 26 illustrates this calculation.
There are a variety of Valuation Functions that correspond to each Health Endpoint. The
Valuation Functions for Mortality health endpoints calculate the VSL multiplied by the All
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Goods Index. The Valuation Functions for Hospital admissions calculate the cost of the hospital
stay and medical care as well as the wages lost while in the hospital.

$500,000

Figure 26. This figure illustrates the health impact cost/benefit equation. In this case it is calculating the benefit of
reducing hospital admissions by 100 (US EPA, 2015a). This same method can also be used for an increase in
hospital admissions and other health endpoints.

There was a choice of distributions for the Mortality Valuation Function. The US EPA
uses the Weibull distribution (Ali Kamal, personal communication, May 9, 2017) because “the
value of a premature death avoided is based on an analysis of 26 policy-relevant value-of-life
studies. A Weibull distribution, with a mean of $4.8 million and standard deviation of $3.24
million, provided the best fit to the 26 estimates” (US EPA 1997).
The identifiers (health endpoint, author, age range, etc.) of the Valuation Functions for
the Hospital Admission (HA) health endpoints match those of the corresponding Health Impact
Functions. The Valuation Function of HA, Chronic Lung Disease (less asthma) was pooled with
HA, Asthma using Sum Independent as the Pooling Method, just as the health impact functions
were.
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While the valuation functions are based on either the currency year of 1990 (mortality) or
2000 (other health impacts), an advanced tool allows the user to adjust for inflation and income
growth. Both have been adjusted to the currency year 2010 for this study. The valuation
functions are described in detail in Table 4.
Table 4
Valuation Functions

Note: P1A is Parameter 1 of the A distribution. P2A is Parameter 2 of the A distribution. CPI-U is the Consumer
Price Index for all Urban consumers. (US EPA, 2015a).

Generate Reports and Export Data
Once the model is run, each Health Impact Function and Valuation Function, pooled or
otherwise, can be drawn in the GIS function in BenMAP-CE (see Figure 27 for an example).
BenMAP-CE also provides a data table for each function (Figure 28). I exported the shapefiles
from BenMAP-CE and brought them into ArcGIS to create the result figures. I also exported the
data tables. The data tables include information about the population in the function’s age range,
point estimates for the incidence or valuation, mean, standard deviation, and so forth. I summed
the population for each function to find the total population in that age range and used that
number in an equation (Equation 1) to find the number of incidences per x number of people in
order to have a standard denominator to compare the outcomes of the different functions. Finally,
an audit trail report can be generated for the model that shows all the inputs and options that
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were selected during the model. A step-by-step guide of all the methods used for this thesis can
be found in the Appendix.
Equation 1. This equation calculates the incidences per a standard number of people so that the results of the
Health Impacts can be compared.

Figure 27. This figure shows an example of health impact results drawn out in BenMAP-CE’s GIS function.
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Figure 28. This figure shows an example of the raw data that BenMAP-CE provides for each Health Impact or
Valuation result.
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Results
BenMAP-CE produced raw data tables that include information for each CMAQ cell in
each Health Impact Function (HIF). These data are summarized in Table 5. BenMAP-CE also
created maps showing the spatial distribution of health incidences and corresponding valuations
due to various levels of chronic exposure to PM2.5 (Figures 29-41).

Health Incidences and Valuation
The area of interest around Pittsburgh, PA is 4,387 km2, with a total population of about
1.2 million. The age range and corresponding population varies based on Health Impact Function
(HIF). To control for this, the data for each HIF were normalized to a population of 1 million in
the HIF’s respective age range. Table 5 shows these normalized data and compares the results of
all mortality and health incidences. The table also compares the costs of these incidences within
the study area.
The table uses the β Effect Estimate, or the percent change of a health effect risk due to a
one-unit change in PM, to determine a low (2.5%), middle best (50%), and high (97.5%)
estimate for each HIF and valuation. For example, the total incidences of adult mortality
according to the Krewski HIF in a population of 1 million for the PA2008 emissions dataset is 8
(low), 12 (middle best estimate), and 16 (high) (Table 5b).
The average Value of a Statistical life, or the cost of a premature death, regardless of age,
was roughly $8 million in 2010 USD. The average cost of Hospital Admissions for all
cardiovascular cases, except heart attacks, was a little over $40,000 per person in 2010 USD.
And the average cost of Hospital Admissions for chronic lung disease was about $37,000 per
person in 2010 USD.
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Heavy duty diesel truck (HDDT) emissions make up just a small part of the overall
ambient PM2.5 emissions. For example, this model estimates that a total of 0.046 µg/m3 of PM2.5
is emitted by high volume hydraulic fracturing (HVHF) related trucks (GIFT2008) across the
AOI, resulting in less than 1 incidences of adult mortality per 1 million adults (Table 5a). Total
PM2.5 emitted by all HDDTs using the 2008 emissions average (PA2008), is 1.577 µg/m3 across
the AOI, resulting in 12-25 adult mortalities per million adults (Table 5b). Conversely, total
PM2.5 emitted by all HDDTs using the model year 2007 emissions standards (PA2007), is 0.262
µg/m3, resulting in just 2-4 adult mortalities per million adults (Table 5c). Meanwhile, ambient
PM2.5 from all emissions sources is 352.84 µg/m3 across the AOI, resulting in a total of 1,197 –
2,341 incidences of adult mortality per 1 million adults (Table 5d).
Regardless of the emissions source, incidences of adult mortality are far greater than
incidences of infant mortality, cardiovascular-related hospital admissions, and respiratory-related
hospital admissions, primarily due to the size of the target population in each HIF. For example,
the PA2008 (Table 5b) emissions set had 12-25 incidences of adult mortality, 1 incidence of
infant mortality, 1 incidence of cardiovascular hospital admissions, and 1 incidence of
respiratory hospital admissions. These all represent the number of incidences due to truck
emissions per a population of 1 million in respective age range, and reflect the lower number of
infants in a population of 1 million, compared to adults age 29-99.
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Table 5. Number of incidences and corresponding valuations of health impacts due to a change in PM 2.5 emissions.
Each sub table shows the results of a different set of PM2.5 emission changes (5a. Ambient, 5b. PA2008, 5c.
GIFT2008, and 5d. PA2007). The Health Impact Functions (HIF) are displayed across the top of each table. The
HIFs are Krewski: adult mortality low range, Lepeule: adult mortality high range, Infant: infant mortality, Cardio.:
hospital admissions for cardiovascular diseases except heart attack, and Resp.: hospital admissions for respiratory
diseases including asthma. In parentheses behind each HIF is the age range of that HIF. The top row of values for
each HIF represents the middle best estimate. The bottom row of values for each HIF represents a range from the
lower 2.5 percentile to the upper 97.5 percentile. The tables are split into two sections. The top section shows the
number of health impact incidences per 1 million people in the age range of the respective HIF, rounded to the
nearest integer. The bottom section shows the valuation of the respective health impacts in 2010 US dollars, in
thousands of dollars. Each section has five sets of values: Min (the CMAQ cell with the lowest value in the HIF),
Max (the CMAQ cell with the highest value), Total (the sum of the values of all CMAQ cells), Avg (the average
value of the CMAQ cells), and StDev (the standard deviation of values of CMAQ cells).
5a. GIFT2008 PM2.5. The estimated heavy duty diesel trucks (HDDT) involved in high volume hydraulic fracturing
(HVHF) material and waste transport, with the EPA average in-use HDDT fleet emission rates in 2008.

* Lower 2.5 percentile, middle best estimate, and upper 97.5 percentile values are all less than 1
** Lower 2.5 percentile, middle best estimate, and upper 97.5 percentile values are all less than $500
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5b. PA2008 PM2.5. Total PA HDDT traffic using the average 2008 emissions.

* Lower 2.5 percentile, middle best estimate, and upper 97.5 percentile values are all less than 1
** Lower 2.5 percentile, middle best estimate, and upper 97.5 percentile values are all less than $500

5c. PA2007 PM2.5. All of the Pennsylvania HDDT traffic if all had upgraded to the EPA's 2007 emissions standards.

* Lower 2.5 percentile, middle best estimate, and upper 97.5 percentile values are all less than 1
** Lower 2.5 percentile, middle best estimate, and upper 97.5 percentile values are all less than $500
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Table 5d. Ambient PM2.5. The ambient baseline PM2.5 in the area of interest as measured by PM2.5 monitors.

* Lower 2.5 percentile, middle best estimate, and upper 97.5 percentile values are all less than 1
** Lower 2.5 percentile, middle best estimate, and upper 97.5 percentile values are all less than $500

Spatial Distribution and Hot Spots
BenMAP-CE created maps that identify hotspots and the spatial distribution of health
incidences, and their valuation, due to PM2.5 emissions exposure. The values in these maps were
not normalized to a population of 1 million and instead represent the raw values. Table 6 shows
the totals of the raw values and Figures 29-41 show the distribution of the incidence and
valuation results.
The areas with the highest rates of incidences are the CMAQ cells in and near Pittsburgh,
regardless of the emissions set or HIF, due to the high population in those cells. However, these
cells don’t necessarily have the highest emissions concentration for their respective emissions
datasets. Emissions sets PA2007 and PA2008 have both the highest PM2.5 emissions and highest
number of incidences, regardless of HIF, in the CMAQ cell that contains Pittsburgh.
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The distribution of the other PM2.5 emissions sets vary. In the GIFT2008 emissions set,
the CMAQ cell with the highest number of health incidences for all HIFs was the cell directly to
the East of Pittsburgh, while its highest rate of emissions occurs several cells to the South.
Ambient levels of PM2.5 had the highest rate of incidences in the cell south of Pittsburgh, while
the highest emissions rate is several cells to the East. Similar to the case of GIFT2008, the cell
with the highest emissions concentrations does not have a large population, so the highest rate of
incidences falls in a cell with both high population and relatively high emissions.

Table 6. This table shows the total Incidence and Valuation values of the raw BenMAP-CE results. Values are
derived from the Point Estimates in BenMAP-CE, which represent the middle best estimate or 50th percentile.
Valuation is in 2010 United States Dollars. The health impact functions (HIFs) are along the top. Krewski
represents the low end of the adult mortality range. Lepeule represents the high end of the adult mortality range.
Infant represents infant mortality. Cardio. represents cardiovascular hospital admissions. Resp. represents
respiratory hospital admissions. The age range of each HIF is in parenthesis after the name. The rows represent
each PM2.5 emissions dataset. GIFT2008: the estimated heavy duty diesel trucks (HDDT) involved in high volume
hydraulic fracturing (HVHF) material and waste transport, with the EPA average in-use HDDT fleet emission rates
in 2008. PA2007: All of the Pennsylvania HDDT traffic if all had upgraded to the EPA's 2007 emissions standards.
PA2008: total PA HDDT traffic using the average 2008 emissions. Ambient: the ambient baseline PM 2.5 in the area
of interest as measured by PM2.5 monitors.
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Adult Mortality Incidences and Valuation

Figure 29. This figure shows the incidences of Adult Mortality in each CMAQ cell across the study area for each
level of PM2.5 emissions (GIFT2008, PA2007, and PA2008). Adult Mortality is measured as a range from the
Krewski to Lepeule Health Impact Functions (HIFs). GIFT2008 total adult mortalities: 0.11-0.26. PA2007 total
adult mortalities: 1.66-3.76. PA2008 total adult mortalities: 9.47-21.44.
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Figure 30. This figure shows the costs incurred by incidences of Adult Mortality in each CMAQ cell across the study
area for each level of PM2.5 emissions (GIFT2008, PA2007, and PA2008). Adult Mortality, and associated costs, are
as a range from the Krewski to Lepeule Health Impact Functions (HIFs). GIFT2008 total cost: $919k-$2.1million.
PA2007 total cost: $13.3 million-$30.1million. PA2008 total cost: $75.8 million-$171.7million.
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Figure 31. This figure shows the incidences of Adult Mortality in each CMAQ cell across the study area for each
level of PM2.5 emissions (1µg/m3 and Ambient). Adult Mortality is measured as a range from the Krewski to Lepeule
Health Impact Functions (HIFs). Total adult mortality: 942.38 - 2,043.74.

Figure 32. This figure shows the costs incurred by incidences of Adult Mortality in each CMAQ cell across the study
area for each level of PM2.5 emissions (1µg/m3 and Ambient). Adult Mortality, and associated costs, are as a range
from the Krewski to Lepeule Health Impact Functions (HIFs). Total cost: $8.3 billion-$18 billion.
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Infant Mortality Incidences and Valuation

Figure 33. This figure shows the incidences of Infant Mortality in each CMAQ cell across the study area for each
level of PM2.5 emissions (GIFT2008, PA2007, and PA2008). GIFT2008 total infant mortalities: 0.0001. PA2007
total infant mortalities: 0.002. PA2008 total infant mortalities: 0.011.

Figure 34. This figure shows the costs incurred by incidences of Infant Mortality in each CMAQ cell across the
study area for each level of PM2.5 emissions (GIFT2008, PA2007, and PA2008). GIFT2008 total cost: $1k. PA2007
total cost: $15k. PA2008 total cost: $87k.

52

Figure 35. This figure shows the incidences of Infant Mortality, as well as the related costs, in each CMAQ cell
across the study area for each level of ambient PM2.5 emissions. Total infant mortalities: 1.04. Total cost:
$9.2million.

Cardiovascular Hospital Admissions Incidences and Valuation

Figure 36. This figure shows the incidences of cardiovascular-related Hospital Admissions (HA), not including
admissions for heart attack, in each CMAQ cell across the study area for each level of PM2.5 emissions (GIFT2008,
PA2007, and PA2008). GIFT2008 total HA: 0.012. PA2007 total HA: 0.168. PA2008 total HA: 0.963.
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Figure 37. This figure shows the costs of cardiovascular-related Hospital Admissions, not including admissions for
heart attack, in each CMAQ cell across the study area for each level of PM2.5 emissions (GIFT2008, PA2007, and
PA2008). GIFT2008 total cost: $500. PA2007 total cost: $6.8k. PA2008: $38.9k.

Figure 38. This figure shows the incidences and related costs of cardiovascular-related Hospital Admissions (HA),
not including admissions for heart attack, in each CMAQ cell across the study area for each level of ambient PM2.5
emissions. Total HA: 98.2. Total cost: $4 million.
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Respiratory Hospital Admissions Incidences and Valuation

Figure 39. This figure shows the incidences of chronic lung disease-related Hospital Admissions (HA) in each
CMAQ cell across the study area for each level of PM2.5 emissions (GIFT2008, PA2007, and PA2008). GIFT2008
total HA: 0.011. PA2007 total HA: 0.155. PA2008 total HA: 0.885.

Figure 40. This figure shows the costs of chronic lung disease-related Hospital Admissions in each CMAQ cell
across the study area for each level of PM2.5 emissions (GIFT2008, PA2007, and PA2008). GIFT2008 total cost:
$400. PA2007 total cost: $5.6k. PA2008 total cost: $32.3k.
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Figure 41. This figure shows the incidences and costs of chronic lung disease-related Hospital Admissions (HA) in
each CMAQ cell across the study area for each level of ambient PM2.5 emissions. Total HA: 122.5. Total cost: $4.5
million.
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Discussion
Discussion of Model Results
This study showed that the approach of using BenMAP-CE, as a modeling tool, was
successful in estimating the relative impacts of HDDT emissions on human health. Although the
accuracy of the results was limited by the quality of the data, the approach itself was successful.
With better data, BenMAP-CE could make more robust estimates with finer spatial detail.
The model, using the data available for this pilot study, showed that GIFT2008 emissions
would cause less than 1 incidence for each health endpoint per 1 million people in the respective
endpoint’s age range. Despite the low impact, these incidences still come with a cost. The cost of
adult mortality, for example, would be about $1 million (Krewski) to $2 million (Lepeule) per 1
million people. The location of these incidences also varies slightly from the location of
incidences caused by typical HDDT emissions (PA2008). This is because HVHF HDDTs tend to
take different routes than typical HDDT traffic, tending to travel more through rural areas, thus
shifting the burden of health incidences onto a different demographic of people.
The rate of incidences and related costs due to all HDDT PM2.5 emissions was, of course,
much more significant. The PA2008 emissions set was responsible for 12 to 25 adult mortalities
per 1 million people, costing the community about $96 million to $197 million. Many of these
deaths could be avoided if the HDDT fleet’s engines were upgraded to the Model Year 2007
emissions standards. This model found that the much lower emissions of the PA2007 dataset was
responsible for just 2 to 4 adult mortalities per 1 million people, at a cost of about $17 million to
$34 million. Clean engine standards can reduce mortalities by about 84%.
This model found that incidences of adult mortality are far greater than incidences of
infant mortality, cardiovascular-related hospital admissions, and respiratory-related hospital
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admissions (table 5). There are several reasons this could be the case. Adult mortality takes into
account all causes of death that could be due to chronic exposure to PM2.5. The Health Impact
Functions (HIF) include a very wide age range (Krewski: 30-99, Lepeule: 25-99). This wide age
range includes the very old who are more susceptible to the effects of pollutants and have been
exposed to PM2.5 much longer than younger people.
Infant mortality also includes all causes of death that could be due to PM2.5 exposure.
However, the number of incidences are likely so low because the infants included in the HIF are
less than 1 year old and have not been exposed to the chronic effects of PM2.5 for very long.
Additionally, there are not many infants in a given population.
Hospital Admissions likely have low rates of incidence for several reasons. The HIFs
only take into account hospital admissions and do not include emergency room visits, doctor
visits, or general symptoms experienced by people who don’t go to the hospital. BenMAP-CE
does not allow the cardiovascular and respiratory hospital admissions to be pooled, so incidences
of PM2.5-induced hospital admissions are split between the two. The age range for the two HIFs
is both narrower and younger (18-64) than that of adult mortality (Krewski: 30-99, Lepeule: 2599), so it does not look at the impacts on as great a range of people. And the people are younger,
which means they are less susceptible than the range of people considered in the adult mortality
HIFs. The hospital admission HIFs are based on single-city studies on the west coast and may
not be representative of the conditions in and around Pittsburgh, PA. Additionally, the
cardiovascular-related hospital admissions do not include heart attacks.
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This model shows the spatial distribution of health impacts and the hot spots where health
impacts were the most significant. Health impacts were concentrated in high population areas,
but this was still dependent on where the pollution was the most concentrated. For example,
typical PA HDDT traffic travels right though the city of Pittsburgh where there is the highest
population in the area of this study. HVHF HDDTs (GIFT2008), however, did not travel straight
through the city, but instead travelled to the east of it. The highest rate of incidences due to
HVHF HDDT traffic was also to the east of Pittsburgh.

Model Assumptions and Weaknesses
This model has some assumptions built into it, many of which carried over from earlier
phases of this research. The first phase of this research estimated data about High Volume
Hydraulic Fracturing (HVHF) Heavy Duty Diesel Trucks (HDDT) because actual data on routes,
truck type, and truck numbers are hard to get from the HVHF companies. This means that actual
HDDT numbers, routes, and time of travel are unknown. We suspect that HDDTs contribute a
significant amount to the spatially and temporally variable PM2.5 load, but the HDDT emissions
data in this model are diluted due to the ways in which HDDT counts were estimated in the GIFT
simulations.
The first phase of this research only considered the HDDTs involved in the transport of
sand, water, and hydraulic fracturing wastes. The number of HDDTs needed was estimated based
on the amount of sand and water used, and the volume of waste produced during the hydraulic
fracturing process. The volume of waste is voluntarily uploaded to the Pennsylvania Department
of Environmental Protection (PADEP) website. The HDDTs involved in the transport of other
equipment or materials was not included. The greatest level of HDDT activity occurs during the
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hydraulic fracturing phase of a well. However, these temporal data were not available, so HVHF
HDDT activity and PM2.5 emissions were averaged out and diluted across an entire year, 24
hours a day, 7 days a week. This eliminates any short term peaks in activity and emissions that
are typically seen when wells are drilled. Additionally, the Pennsylvania Department of
Transportation (PADOT) doesn’t monitor HDDT counts on all rural roads, where there are more
HVHF HDDTs due to the locations of HVHF wells. Because neither PADOT nor HVHF
companies provided clues to the routes of HVHF HDDTs in rural areas, their routes were
modelled using ArcGIS. Even non-HVHF HDDT traffic was estimated. PADOT provides
average daily HDDT estimates. These were multiplied by 365 to get average HDDT counts for
the year to match the GIFT annual time frame (Korfmacher, et al., 2016). This also erases any
temporal spikes in traffic.
In the second phase of this research the emissions concentration and dispersal of these
emissions were modeled with AERMOD. The emissions were estimated using the HDDT counts
and routes from the previous phase along with average fleet emissions as calculated by the EPA.
The two emissions rates used were the average emissions of all HDDTs in operation in 2008,
regardless of the model years of those vehicles, and the emissions rate of the HDDT fleet if all
vehicles were compliant with the more stringent 2007 EPA emissions regulations. Actual
emissions values are hard to calculate in part due to the uncertainty of HDDT numbers, routes,
and lack of data on the types of HDDTs themselves, so the emissions values had to be estimated
based on the best available averages.
In the third phase, the emissions concentration and dispersal from phase two were
averaged out across 12 km CMAQ cells (area of 144 km2) to be processed in BenMAP-CE. This
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further diluted the HDDT PM2.5 emissions from roadsides to 12x12 km boxes. This was a
limitation of BenMAP-CE, based on the databases provided with the model.
All three phases of this research estimated and averaged data, resulting in dilution of
HDDT emissions. Therefore, the impacts on health due to HDDT PM2.5 emissions were likely
diluted. More robust input data about HDDT routes, numbers, and emissions should result in
model outputs closer to the real-world values. I suspect that the actual impacts of HDDT PM2.5
emissions on various health endpoints and their concurrent costs would be greater and more
significant than this model suggests, and that rural areas are seeing greater health impacts due to
HVHF emissions than the EPA monitoring data suggest.

Potential Uses of Model Results in Policy and Planning Applications
This model provides hotspot information and estimates of health effects and costs due to
PM2.5 emissions that can be used as a base for further research or for policy and planning
applications. The hotspots help to identify the locations that are likely hit the hardest by
pollution, and the demographics of those areas, even if the health impacts are diluted in this
analysis. This information can be used to put policy in place to lessen the effects of pollution in
those areas and on those specific demographics. The hotspots also identify places where the
placement of additional emissions monitors would be helpful to have a better understanding of
the emissions concentrations and health impacts in those areas. These rural monitors and their
data trends would bolster policy recommendations.
The information from this model can also be used to determine the cost/benefits of
changes to emissions regulations. For example, even with the data limitations, this model showed
a large difference in numbers of health impacts between those of the average HDDT emissions in
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2008, and the emissions of HDDT if they had all been upgraded to EPA’s 2007 emissions
standards. The total PM2.5 across the AOI for PA2008 was 1.577µg/m3, with an adult mortality
cost of 12-25 per 1 million adults. PA2007, however, had a total PM2.5 of just 0.262µg/m3, with
an adult mortality cost of 2-4 per 1 million adults.

Guidance on Choosing Health Impact Functions
BenMAP-CE has a plethora of options when it comes to Health Impact Functions (HIF).
Ali Kamal suggested choosing HIFs that have an interesting endpoint. Kamal also said that the
EPA “rarely look at one study for a health endpoint alone, we often pool them together as a set
based on similar study bounds,” however adult mortality is shown as a range using Krewski to
Lepeule (Personal communication with Ali Kamal, June 7, 2017.) Additionally, the populations
in the studies that BenMAP-CE references for its HIFs should ideally be as similar as possible to
the populations being studied in the health cost/benefit analysis (Fann et al., 2009).

Future Research Ideas
There are a few ways in which this model could be improved. Better data on HDDTs and
their emissions would be ideal, but as that may not be possible, it would be good to reduce the
amount of dilution of HDDTs and their emissions as much as possible. One way to do that would
be to decrease the size of the cells used in BenMAP-CE. Instead of using the 12 km CMAQ grid,
we could use a 1 km2 grid. This would reduce emissions dilution and provide finer resolution of
emissions hotspots, allowing for a more accurate understanding of the locations and
demographics experiencing the highest health incidences due to pollutants. This would also
require revised population distributions using POPGRID and recalculating the pollution levels
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through interpolation of EPA monitoring data. These changes would significantly increase the
size of the database used, and it is unknown how that might effect BenMAP performance and
accuracy.
Even though the health impacts and related costs of HVHF-related HDDT traffic are
small compared to all HDDT traffic in and around Pittsburgh, PA, HVHF HDDT traffic can
disproportionately affect different communities of people due to using different routes than
typical HDDT traffic. Rural communities near HVHF activity may see a more pronounced
impact from HVHF HDDT emissions as compared to all HDDT traffic and should be studied in
future research.
The Baseline PM2.5 emissions for the study area were calculated using data from air
quality monitoring stations scattered around the area. These monitors are placed unevenly across
Pennsylvania, with highest concentrations in and around urban areas, and very few in rural areas.
The Voronoi neighborhood averaging of air quality data in BenMAP-CE works well, but is not
nearly as robust as other emissions dispersal modeling software, such as AERMOD, and cannot
account for the impacts of varying terrain on the dispersal and concentration of emissions. It is
hard to know what the actual baseline air quality is in rural areas, especially considering the
heavy HVHF HDDT traffic coupled with the lack of monitors in those areas. Additional
monitors would need to be placed in rural areas in conjunction with the use of more robust
emissions dispersal software to develop a better model of the baseline air quality. Hotspots
identified in this analysis and similar studies could represent good places to put additional
monitors.
It is likely that the actual movements of HVHF HDDTs would produce high
concentration spikes of PM2.5 over short periods of time, as opposed to the steady, low
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concentration of PM2.5 averaged over an entire year in this study. This pilot study modeled the
effects of chronic exposure to PM2.5 due to data considerations. Chronic exposure can reduce life
expectancy (Brook et al. 2010), and can lead to reduced lung function and chronic respiratory
disease in children (US EPA, 2006). The effects of acute PM2.5 exposure, however, can
exacerbate respiratory and cardiovascular symptoms in susceptible individuals and result in
respiratory and cardiovascular-related mortality (Brook et al., 2010; US EPA, 2006).
This model only studies the impacts of primarily produced PM2.5. PM2.5 created by
secondary chemical reactions of other pollutants from diesel engines may also have an impact.
HDDTs also emit other harmful pollutants such as: CO2, CO, VOCs, NOx, and SOx, the effects
of which should also be studied. The human health impact of HDDTs may be much greater if the
rest of these emissions are also taken into account. The impacts of these other emissions could be
modeled in BenMAP-CE, however, the program currently only has built-in data for PM2.5 and
ozone. Other pollutants and corresponding Health Impact Functions would have to be added by
the user.
HVHF activity also emits pollutants from sources besides HDDTs. Further research on
the health and environmental impacts of HVHF emissions, particularly from the well site, are
important for a more complete understanding of the effects of HVHF activity on human health
and the environment.
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Conclusions
This thesis is the pilot study for the third phase of a larger project that studies the effects
of High Volume Hydraulic Fracturing (HVHF) Heavy Duty Diesel Truck (HDDT) emissions on
human health. It developed the methodology to model health impacts with BenMAP-CE, using
data from the previous phases of this project. Previous phases modeled the road networks likely
used by HVHF-HDDTs, and emissions concentration and dispersion of HVHF-HDDTs and PA
HDDTs. This model specifically looked at the effects of PM2.5 emissions on adult mortality,
infant mortality, respiratory-related hospital admissions, and cardiovascular-related hospital
admissions in the population of the area of interest in and around Pittsburgh, PA. It also
compared the effects of HVHF-HDDT emissions to all PA HDDTs with average 2008 emissions
rates, all PA HDDTs with 2007 regulations emissions rates, and ambient PM2.5 emissions.
The model highlighted hotspots of increased health incidences. However, the estimated
values are likely suppressed due to data estimation and averaging both in this phase and previous
phases of the project. Although the results were diluted, the model found that emissions
regulations can have a large positive impact on reducing health impacts. It also showed that
HVHF HDDTs impact different communities than typical PA HDDT traffic, due to HVHF
HDDTs traveling on different routes. These can help in the design of future monitoring activities
and studies.
This pilot study showed that BenMAP-CE, as a modeling tool, is successful at estimating
the relative impacts of HDDT emissions on human health. The methodology developed herein
can be used in future aspects of this research to model the health impacts of HVHF-related
emissions on human health.
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Appendix: Step-by-Step Methods
This appendix is a step-by-step manual of the methods used in this thesis. It covers data
preparation, modifying AERMOD output data for input into BenMAP-CE, and the use of
BenMAP-CE itself.

A.1 Base Data Preparation
The following steps only need to be completed once regardless of how many sets of AERMOD
emissions data you have.
A.1.1 Export Data from BenMAP-CE
 BenMAP-CE comes with a number of useful datasets that can be used to run your own
health impact models. Some of these need to be exported so they can be imported into a
new Setup. Others need to be exported so they can be manipulated in other programs
before being brought back into BenMAP-CE.
A.1.1.1 Export Datasets
 When a new Setup is created the Datasets windows are cleared out. The relevant Datasets
need to be exported from the United States Setup so that they can then be imported into
the new Setup. First, decide which datasets are relevant and should be exported.
A.1.1.1.1 Find Datasets to Export



Open BenMAP-CE. A Welcome screen will pop up in front of the main application.



o
Click OK and go to the main window.
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o
Make sure United States is listed in the menu bar, if not, click the drop down arrow next
to the location name and select United States.
Click on Modify Datasets in the menu bar. This will open up the Modify Datasets
window. Make sure United States is selected in the Available Setups dropdown.
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o
Click the Manage button under the Incidence/Prevalence Rates window.



o
Select a dataset in the Available Datasets window on the left. The window on the right
will show the Health Endpoints that are available in that dataset. Choose datasets based
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on how close they are to your year of interest and whether they have the Health
Endpoints you are interested in. Remember to consider if the Health Endpoints make
sense based on the emissions data.
Click Edit to open the Incidence Dataset Definition window to find more information
about the Dataset.

o
Click OK twice to return to the Modify Datasets window.
Click the Manage button under the Health Impact Functions window and follow similar
steps to find the relevant Health Impact Functions.

A.1.1.1.2 List of Datasets to Export (Datasets Used in This Thesis)
 Incidence/Prevalence Rates
o Mortality Incidence (2010)
o Other Incidence (2007)
 Health Impact Functions
o EPA Standard Health Functions
o PM NAAQS Final 2012 Additional Functions
 Variable Datasets
o EPA Standard Variables
 Inflation Datasets
o EPA Standard Inflators
 Valuation Functions
o EPA Standard Valuation Functions
 Income Growth Adjustments
o EPA Standard Income Growth
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NOTE: The other Datasets are either not necessary, or we will create and import our own.

A.1.1.1.3 Export Datasets
 To export these datasets, return to the main BenMAP-CE window.



o
Click on Tools in the menu bar. Select Database Export. This will bring up the Database
Export window.



o
Click the “+” symbol in front of United States to open up that menu.
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o
Click on the “+” symbol in front of the first set of Datasets you’d like to export. In this
case, Incidence/Prevalence Datasets.



o
Click the individual dataset you want to export. For example, “Mortality Incidence
(2010)” then click OK. This will bring up the Save As window.
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o
Save the file to an appropriate location. Give it the same name as the Dataset name,
“Mortality Incidence (2010). It will save as a .bdbx file, which can only be opened in
BenMAP-CE. Click Save.
It may take a few minutes to complete exporting. A window will pop up once the file has
exported successfully.

o
Click OK
Repeat for the rest of the datasets you want to export. Click Cancel on the Database
Export window when finished, and you’ll be returned to the main screen.

A.1.1.2 Export Grid Definitions
 Grid definition shapefiles cannot be exported with the database export tool in BenMAPCE because that tool only gives the option of saving as a .bdbx file, which is specific to
BenMAP-CE. Grid definitions need to be exported as shapefiles so they can be
manipulated in ArcGIS to represent the area of interest of the project. There is an indirect
way to export Grid Definitions as shapefiles.
A.1.1.2.1 Export CMAQ Grid
 BenMAP-CE’s CMAQ grid will serve as the base shapefile for the AOI, emissions,
population, health impacts, valuation, and spatially connect my data to the data in
BenMAP-CE’s datasets.
 Go to the main BenMAP-CE window.
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o
Make sure United States is listed in the menu bar, if not, click the drop down arrow next
to the location name and select United States.
On the left of the main window, double click on “Pollutant” under “1. Air Quality
Surfaces” and the Pollutant Definition window will come up.

o
Click, drag and drop PM2.5 from the Pollutants list to the Selected Pollutants list.
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o
Click OK. You will be returned to the main window.
The main window will now look like this. Note the bubble next to Pollutant has turned
green.



o
On the left, double click on “Baseline” under “Source of Air Quality Data” and the
Choose a Grid Creation Method window will pop up.
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o
For Grid Type, choose “CMAQ 12km Nation – Clipped” from the drop down menu. And
select Monitor Data.



o
Click Next and the Monitor Data window will pop up.
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o
Click the Map button



o
Right-click on “Air quality grid.” Hover over “Data” in the popup menu. Click “Export
Data.” Export Feature Data window will come up.




o
Make sure “All Features” is selected in the Export dropdown.
Click on the Folder icon and navigate to the appropriate folder. Choose Shapefile as the
file type. Name the file 12kmCMAQGrid_Nation.
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o
Click Save. You’ll be returned to the Export Feature Data window.




o
Click OK.
A notice may pop up.




o
Click No.
You’ll be returned to the MonitorMap screen. Exit out of it and return to the main
window.

A.1.1.2.2 Export State Grid
 Double Click on Baseline in the left menu. This brings up the Choose a Grid Creation
Method window.
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o
Choose State in the Grid Type dropdown menu, and select Monitor Data



o
Click Next. The Monitor Data window will appear.
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o
Click the Map button. The MonitorMap window will come up.



o
Right-click on “Air quality grid.” Hover over “Data” in the popup menu. Click “Export
Data.” Export Feature Data window will come up.
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o
Make sure “All Features” is selected in the Export dropdown.
Click on the Folder icon and navigate to the appropriate folder. Choose Shapefile as the
file type. Name the file StatesGrid_Nation.



o
Click Save. You’ll be returned to the Export Feature Data window.




o
Click OK.
A notice may pop up.
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o
Click No.
You’ll be returned to the MonitorMap screen. Exit out of it and return to the main
window.

(Optional): Follow similar steps to export the County Grid Definition.
A.1.2 Prepare Emissions Monitoring Data
A.1.2.1 ArcGIS - Clip CMAQ Grid to Marcellus Shale States
A.1.2.1.1 Open New Blank Map in ArcGIS
 Open a new blank map in ArcGIS. Navigate to the correct default geodatabase.



o
Click OK. You’ll be taking to a new, blank map.
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o
Right click on ArcToolbox in the right window. Click on Environments. The
Environment Settings window will come up.

o
Click on Workspace. Navigate to an appropriate folder for the Current Workspace, which
will be the default location for geoprocessing tool inputs and outputs. The Scratch
Workspace will remain as Default.gdb.
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o
Click OK to return to the main window.
Click on File, then Save As. The Save As window will come up. Navigate to the
Appropriate Folder and save this map as Marcellus.



o
Click Save and you’ll be returned to the main screen.

A.1.2.1.2 Add BenMAP-CE Shapefiles and Define Projection
 To add shapefiles click on the Add Data button on the toolbar. The Add Data window
will appear. Navigate to the BenMAP_Shapefiles folder. Select all three shapefiles
(12kmCMAQGrid_Nation, CountyGrid_Nation, and StatesGrid_Nation) then click Add.
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o
A warning window about the shapefiles having an unknown spatial reference will pop up.



o
Click OK and you’ll be returned to the main window where the three shapefiles will be
drawn.
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o
Right-click on StatesGrid_Nation, then click on Properties in the pop-up menu (or simply
double-click on the layer name). This brings up the Layer Properties window. Click on
the Source tab. You will see that the StatesGrid_Nation shapefile has the Coordinate
System: GCS_North_American_1983, also known as Geographic Coordinate System:
North American Datum 1983. This is the projection that BenMAP-CE uses, so make sure
to use this projection for all other shapefiles.

o
Click OK then open the Layer properties for the other shapefiles. You will see that both
12kmCMAQGrid_Nation and CountyGrid_Nation have an undefined coordinate system.
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o
We need to define the projection of these shapefiles. In the main window navigate to
ArcToolbox -> Data Management Tools -> Projections and Transformations. Then
double-click on Define Projection to bring up the Define Projection tool

o
In the Input Dataset or Feature Class dropdown, select 12kmCMAQGrid_Nation. The
Coordinate System box will show “Unknown.”
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o
Click on the button next to the Coordinate System box. This brings up the Spatial
Reference Properties window.

o
Click the “+” sign next to the Geographic Coordinate Systems folder. Then click on the
“+” sign next to the North America subfolder. Scroll down until you see a globe symbol
with NAD 1983. Select it.
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o
Click on the star symbol in the toolbar to make this coordinate system a favorite so it will
be easier to find later.



o
Make sure the correct coordinate system is selected then click OK.
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o
Click OK again. A blue box with a green check mark will appear in the lower right when
the tool has completed successfully.



o
Repeat steps to define the projection for CountyGrid_Nation.
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o
Click OK and return to the main screen.

A.1.2.1.3 Clip shapefiles to Marcellus region
A.1.2.1.3.1 Select and export Marcellus states to new shapefile
 Turn off the CMAQ and County layers so that only the States layer is visible.



o
In the menu bar click on Selection, then click Select by Attributes, which will bring up
the corresponding window. We will be selecting the five states which contain the
Marcellus shale (Maryland, New York, Ohio, Pennsylvania, and West Virginia).
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o
In the Layer dropdown menu make sure StatesGrid_Nation is selected. Click on
“STATE_NAME” then click on the Get Unique Values Button. The window will
populate with state names.

o
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To create the selection formula, double-click on “STATE_NAME,” then click the “=”
button, then double-click on “Maryland.” Then click the “Or” button and repeat until all
five states have been selected and the selection formula looks like this:



o
Click OK. The five states should be selected.



o
Right-click on StatesGrid_Nation. In the pop-up menu hover over Data, the click on
Export Data, which will bring up a new window.
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o
Make sure Selected Features is shown in the Export dropdown menu. Click on the File
button, which will bring up the Saving Data window. Navigate to the Marcellus folder
then save the new shapefile as StatesGrid_Marcellus.shp.

o
Click Save and you’ll be returned to the Export Data window.
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o
Make sure the Output Feature Class file path and name is correct. Click OK.
After it exports, you’ll be asked if you want to add the exported data to the map.



o
Click Yes.



o
Now we have a new shapefile with just the states in the Marcellus shale region which we
will use to clip the CMAQ and Counties shapefiles.
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A.1.2.1.3.2 Clip CMAQ grid to Marcellus States
 Click on Geoprocessing in the menu bar. Then click on Clip. This brings up the Clip tool





o
In the Input Features dropdown, select 12kmCMAQGrid_Nation. In the Clip Features
dropdown, select StatesGrid_Marcellus.

o
Click on the File button next to the Output Feature Class box, which brings up the
corresponding window. Navigate to the Marcellus folder. Name the new shapefile
12kmCMAQGrid_Marcellus.
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o
Click Save. The Clip tool window should now look like this:



o
Click OK. Once it has successfully completed clipping the shapefile, it should look like
this:
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o

A.1.2.2 BenMAP-CE – Create Monitoring Data Shapefile
A.1.2.2.1 Create new setup
 Open BenMAP-CE, then click on Modify Datasets in the menu bar to open the Modify
Datasets window

o
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To create a new setup, click the Add button at the top. A New Setup window will appear.



o
Name the new setup “Marcellus CMAQ”



o
Click OK. Now “Marcellus CMAQ” will be an option in the Available Setups dropdown,
and all boxes will be blank.

o
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A.1.2.2.2 Add Grid Definitions
 Click on the Manage button under the Grid Definitions box





o
Click “Add.”

o
In the Grid ID box, type “Marcellus CMAQ.” In the Grid Type dropdown, make sure
Shapefile Grid is selected. Click on the Folder icon next to the Load Shapefile box.
Navigate to the Marcellus folder, find and select the 12kmCMAQ_Grid_Marcellus
shapefile. The shapefile will load and appear in the window on the right.
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o
Click OK. In the Manage Grid Definitions window, “Marcellus CMAQ” should appear in
the Available Grid Definitions window. In the Default Grid Type dropdown, select
“Marcellus CMAQ.”

o
Click OK and you’ll be returned to the Modify Datasets window, where the new Grid
Definition should appear.

107

o
A.1.2.2.3 Add Pollutants
 In the Manage Datasets window, click on the Manage button under the Pollutants box.
The Manage Pollutants window will pop up.

o
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Click Add. This will bring up the Pollutant Definition window.



o
Type “PM2.5” in the Pollutant ID box. Make sure it is spelled correctly.



o
In the Observation Type dropdown select Daily.
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o
Under the Metrics box click the Add button. “Metric 0” will appear in the Metrics box,
and in the Metric Name box in the right side of the window under Detail.



o
Click on the Metric Name box and change the name from Metric 0 to D24HourMean.
This tells BenMAP-CE that PM2.5 is averaged across 24 hours in each day.
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o
Click the Edit button under Seasonal Metrics box. The Manage Seasonal Metrics window
will open.



o
Click Add under the Seasonal Metrics box. This will add “SeasonalMetric 0” to the
Seasonal Metrics box and the Seasonal Metric Name box.
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o
In the Seasonal Metric Name box clear out “SeasonalMetric 0 and type “YearlyAvg” and
hit Enter, this name will update into the Seasonal Metrics box. The Start and End date
should span a whole year. Choose Mean in the Statistics dropdown. Do not add Seasonal
Metric Seasons. We are using a yearly mean because that is how the HDDT emissions
concentration was calculated in AERMOD.

o
Click OK, this will bring up the Pollutant Definition window. Click OK in the Pollutant
Definition window. The Manage Pollutants window should now be on top and should
show PM2.5 in the Available Pollutants window, with D24HourMean in the Pollutant
Metrics window.
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o
Click OK to return to the he Modify Datasets window, which should now show PM2.5 in
the Pollutants window.

o
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A.1.2.2.3.1 Export Pollutant Dataset
 Return to the main window



o
Click on the Tools dropdown, then select Database Export



o
Click the “+” in front of Marcellus CMAQ. Then click the “+” in front of Pollutant.
Select Pollutant
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o
Click OK. The Save As window will come up. Navigate to the Datasets folder inside the
BenMAPCE_Data folder.



o
Create a new folder called Marcellus. Inside that folder, name the file PM25
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o
Click Save.



o
Click OK and close out of the Database Export window.

A.1.2.2.4 Add Monitoring Data
 Make sure monitoring data is set up in an Excel document like this. (Karl has steps for
this)

o
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Click the Manage button under the Monitor Datasets box in the Modify Datasets window.
The Manage Monitor Datasets window will come up.

o
Click the Add button under the Available Datasets box. The Monitor Dataset Definition
window will come up.

o
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Enter “UTRC PM2.5” in the Dataset Name box. Make sure PM2.5 is selected in the
Pollutant dropdown menu. Enter 2011 in the Year box.

o
Click on the Load Data From File button. The Load Monitor Dataset window will come
up. Click Browse and select the appropriate file. Then click the Validate button.

o
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o
Make sure there are no errors in the Validating Data import window and click OK. Then
click OK on the Load Monitor Dataset window. Click OK on the Confirm Edit window.
The file may take a minute to load, once it does, the window will include information
about the file you just loaded.
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o
Click OK and you will be returned to the Manage Monitor Datasets window, which will
now show information about your dataset.

o
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To add more years to the desired dataset, click on it in the Available Datasets box and
then click the Edit button. Then repeat the previous steps until all applicable datasets
have been loaded. Not necessary for this project.
Click OK and return to the Modify Datasets window.

o

A.1.2.2.5 Create Monitoring Data Map
 On the main BenMAP-CE screen, make sure that Marcellus CMAQ is selected in the
drop down at the top of the screen
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o
Double-click on Pollutant, which is on the left menu bar under 1 Air Quality Surfaces.
The Pollutant Definition window will come up.



o
Drag and drop PM2.5 from the Pollutants box to the Selected Pollutants box.
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o
Click OK. The circle in front of Pollutants should now be green.

o
Double click on Baseline under Source of Air Quality Data. The Choose a Grid Creation
Method window will pop up. Make sure Marcellus CMAQ is selected in the Grid Type
drop down, and that Monitor Data is selected.
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o
Click Next. The Monitor Data window will come up. On the left under Interpolation
Method, check Voronoi Neighborhood Averaging. On the right, make sure Library is
selected in the Monitor Dataset dropdown, In the Library box, select UTRC PM2.5 in the
Monitor Dataset dropdown. Select 2011 (or your year of interest) in the Monitor Library
Year dropdown.
Voronoi Neighborhood Averaging calculates an inverse-distance weighted average of the
neighboring monitors that “surround” each grid cell.

o
Click Next. BenMAP-CE will prompt you to save as an AQG file. Name the file
MarcellusCMAQ_Baseline. Click Save.
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You will be returned to the main screen. The circle in front of Baseline will now be
green, and there will be a Base Data icon underneath it.

o
Double-click on Base Data and BenMAP-CE will draw a map of average PM2.5.

o
Click on the Save icon on the left of the map area. This will save the map as a shapefile
that can be opened in ArcGIS. Navigate to the Marcellus folder and name the shapefile
MarcellusCMAQ_Baseline.
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o
Click Save



o
Click OK.

A.1.2.3 ArcGIS – Create AOI CMAQ Grid
Clip the CMAQ grid from BenMAP-CE to the Pittsburgh area of interest in order to create a
Grid Definition for the AOI. Make sure to keep all of the columns from the original CMAQ grid
in new grid, otherwise things won’t work correctly in BenMAP-CE later on.
A.1.2.3.1 Open new Blank Map
 Open ArcGIS. Create a new Blank Map. Make sure it is going to the correct default
geodatabase.
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o
Click OK
Save the map document as PA2007
Go to Environments and change the Current Workspace to a folder named “PA2007”



o
Next, click on Output Coordinates.
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o
In the Output Coordinate System dropdown, select “As Specified Below.” Click the
lookup button to bring up the Spatial Reference Properties window.



o
Select NAD 1983 then click OK.
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o
Click OK

A.1.2.3.2 Add CMAQ and AERMOD shapefiles
 Click on the Add Data button. Navigate to the Marcellus folder and select
12kmCMAQGrid_Marcellus



o
Click Add to return to the main screen
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o
Click on the Add Data button. Navigate to the PA 2007 AERMOD data. Select all
shapefiles



o
Click Add

o
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Right click on one of the layers and click Group. Then name the Group layer “PA2007
AERMOD”

o

o
A.1.2.3.3 Project CMAQ grid to same projection as AERMOD shapefiles
 The AERMOD shapefiles are in the projected coordinate system:
NAD_1983_UTM_Zone_18N
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o
For the sake of efficiency, convert 12kmCMAQGrid_Marcellus to
NAD_1983_UTM_Zone_18N, instead of converting all of the AERMOD files to
GCS_North_American_1983.
Go to ArcToolbox -> Data Management Tools -> Projections and Transformations ->
Project

o
In the Input Dataset or Feature Class dropdown, select 12kmCMAQGrid_Marcellus.
Click on the folder icon next to Output Dataset or Feature class. Navigate to the
Marcellus folder and name the new shapefile 12kmCMAQGrid_Marcellus_UTM18N.

132

Then click on the lookup button next to the Output Coordinate System box and select
NAD 1983 UTM Zone 18N



o
Click OK. It may take a little time for ArcGIS to project the shapefile. Once it is done, it
should look like this:



o
You will notice that there is no obvious difference between the two CMAQ projections.
But it’s better to be safe.

A.1.2.3.4 Create AOI CMAQ grid
 Use the Select Features tool in the toolbar to select each grid in
12kmCMAQGrid_Marcellus_UTM18N that completely encompasses an AERMOD
shapefile. Hold down the Shift key to select more than one grid at a time.
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o
Right click on the 12kmCMAQGrid_Marcellus_UTM18N layer. In the popup menu,
hover over Data, then click on Export Data in the second menu.

o
Make sure Selected Features is selected in the Export dropdown menu. Use the same
coordinate system as this layer’s source data.
Click on the folder button next to the Output feature class box. Create a folder named
Pittsburgh. Name the new shapefile CMAQGrid_Pittsburgh18N
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o
Click Save to return to the Export Data window.



o
Click OK.



o
Click Yes
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o
A.1.2.3.5 Project CMAQGrid_Pittsburgh to NAD83
 Change projection of the Pittsburgh CMAQ grid back to NAD 83. ArcToolbox -> Data
Management Tools -> Projections and Transformations -> Project.
 Select CMAQGrid_Pittsburgh18N in the Input Dataset or Feature Class dropdown. For
the Output Dataset or Feature class, navigate to the Pittsburgh folder and name the new
shapefile CMAQGrid_Pittsburgh. Make sure the Output Coordinate System is
GCS_North_American_1983.



o
Click OK.
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o
Open the attribute table of CMAQGrid_Pittsburgh. It should have all of these columns.
All of these are necessary for things to work correctly in BenMAP-CE later.



o
Save and close this map document. We’ll come back to it later.

A.1.2.4 ArcGIS – Create Baseline of Pittsburgh CMAQ Monitoring Emissions
 Open the Marcellus map.

o
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A.1.2.4.1 Add and Project MarcellusCMAQ_Baseline
 Add Data. First add the MarcellusCMAQ_Baseline that was created in BenMAP-CE in
an earlier step.



o
Click Add. A Geographic Coordinate Systems Warning may pop up.



o
Click on Transformations.
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o
Click OK. Then click Close on the Warning window. This will return you to the main
ArcGIS screen.



o
Double click on the MarcellusCMAQ_Baseline layer to go to Properties, then the Source
tab, and double-check the coordinate system.
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o
It is not in the correct coordinate system so it will need to be projected. Open the Project
tool.
In the Input Dataset dropdown, select MarcellusCMAQ_Baseline. Name the new
shapefile MarcellusCMAQ_BaselineNAD83 and save it in the Marcellus folder. Make
sure the Output Coordinate System is NAD 1983 (GCS_North_American_1983). Also
make sure to choose “NAD_1983_To_WGS_1984_1” in the Geographic Transformation
dropdown. Do not let it use the default transformation as that will make the resulting
CMAQ squares not line up quite right. Click on the default, then click the X button to get
rid of the default transformation.
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o
Click OK

o
A.1.2.4.2 Add CMAQGrid_Pittsburgh
 Add data. Navigate to the Pittsburgh folder and select CMAQGrid_Pittsburgh.
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o
Click Add. Then Zoom to Layer

o
A.1.2.4.3 Clip MarcellusCMAQ_BaselineNAD83 with CMAQGrid_Pittsburgh
 Click on Geoprocessing in the menu bar. Then open the Clip tool.
 Choose MarcellusCMAQ_BaselineNAD83 in the Input Features dropdown. Choose
CMAQGrid_Pittsburgh as the Clip Features. Save the Output Feature Class in the
Pittsburgh folder as CMAQPittsburgh_Baseline.
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o
Click OK

o
A.1.2.4.4 Export table from CMAQPittsburgh_Baseline
 Open the attribute table. The COL and ROW column numbers match those in the
CMAQGrid_Pittsburgh shapefile. The Baseline data will be entered into BenMAP_CE as
a .csv file.
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o
Click on the down arrow next to the Table Options button. Click on Export. The Export
Data window will open.



o
Click on the Browse button. Navigate to the Pittsburgh folder. Save as type: Text File.
But put .CSV at the end. Name it: CMAQPittsburgh_Baseline.csv.



o
Click Save
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o
Click OK.



o
Click No. Do not add the new table to the map.

A.1.2.5 Excel – Edit Baseline .csv file
A.1.2.5.1 Open CMAQPittsburgh_Baseline.csv in Excel
 Start Excel. In the start screen click on Open Other Workbooks. Then click on Browse.
Make sure to select All Files in the dropdown menu above the Open button. Navigate to
the Pittsburgh folder and click on CMAQPittsburgh_Baseline.

o
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Click Open



o
Edit and move around columns until they look like this:





o
Make sure all of the column headers are spelled correctly. The Metric, Seasonal Metric,
and Annual Metric values must match those that were created in the Pollutant Definitions
in BenMAP-CE.
Save the Excel file.
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o
Click Yes to keep the file in CSV format.
Close Excel.

A.1.3 Prepare Population Data with PopGrid
 PopGrid allocates the 2010 block-level U.S. Census population to a user-defined grid,
creating a population file ready for importation to BenMAP-CE. It is a separate program
that should download with BenMAP-CE. You should be able to find it in the folder with
the rest of BenMAP-Ce. If not, it can be downloaded here:
https://www.epa.gov/benmap/benmap-community-edition
A.1.3.1 Step 1: Data
 Open PopGrid v4.3



o
Click on the Browse button next to Census Data Files Directory.

147





o
Click on Data3 then click OK

o
Click the Browse button next to the Result Population File box. Navigate to the Results
folder in the PopGrid v4.3 – Census 2010 folder. Name the file
Pittsburgh_2010_POP.csv. Make sure to add the .csv extension.
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o
Click Save

o
A.1.3.2 Step 2: Shape File
 Click on the second tab, Step 2: Shape File
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o
Click on the Browse button next to the Shape File box. Navigate to the Pittsburgh folder
and choose the CMAQGrid_Pittsburgh shapefile.



o
Click Open.
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o
A.1.3.3 Step 3: Run
 Click on the third tab, Step 3: Run

o
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o
It might say Not Responding while it is running. This is ok. Just let it do its thing.
Once it is done, PopGrid will close on its own and a Notepad document will open
showing a log.

o
You can close this file.
The resulting file is named Pittsburgh_2010_POP.csv and can be found in the PopGrid
Results folder (as was done in Step 1), and is ready to go for BenMAP-CE. PopGrid also
created a weighted population file (popwgt on the end of the file name).

152

o

A.2 Data Preparation for each set of AERMOD data
The following steps need to be repeated for each set of AERMOD emissions data that will be
analyzed in BenMAP-CE.
A.2.1 Prepare Air Quality Modeling shapefiles
 Open ArcMAP and open the PA2007 file that was started in an earlier step.



o
Remove both of the 12kmCMAQGrid_Marcellus shapefiles by right-clicking on the
layers and clicking Remove. Turn off the CMAQGrid_Pittsburgh layer by unchecking its
layer box. Make CMAQGrid_Pittsburgh18N transparent by double-clicking on the
colored box underneath the layer name, then changing the Fill Color to No Color.
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o
A.2.1.1 Clip AERMOD shapefiles to respective CMAQ grid
 Open up the PA2007 AERMOD layer group. Turn off the first sublayer. Then use the
Select Features tool to select the CMAQ grid where that sublayer is. Note the grid cell
with the blue outline.



o
Click on Geoprocessing in the menu bar, then click on Clip.
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o
In the Input Features dropdown, select the AERMOD shapefile that you used to select the
CMAQ grid. In the Clip Features dropdown, select CMAQGrid_Pittsburgh18N. For the
Output Feature Class, navigate to the PA2007 folder, then make a subfolder named
AERMOD_Clips. Save the new shapefile inside that folder and give it the same name as
the corresponding AERMOD file but with Clip at the end instead of ANN.
“PA_317147_2011_2007_Clip”

o
Click OK
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o
Repeat for the remaining AERMOD shapefiles until they have all been clipped to fit the
CMAQ grid.



o
Select all of the clipped AERMOD shapefiles, then right-click and select Group to put
them all into a group. Name the group PA2007 AERMOD Clips.

o
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A.2.1.2 Calculate the weighted average emission concentration of each clipped AERMOD grid
 Expand the PA2007 AERMOD Clips group.







o
Open the attribute table for the first clipped AERMOD file.

o
Click on the Table Options dropdown menu, then click Add Field. In the Add Field
window, type “Area” in the Name box. Select Double in the Type dropdown. In the Field
Properties, enter 15 for Precision, and 4 for Scale.

o
Click OK.
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o
Right click on the new Area field and click on Calculate Geometry. In the Calculate
Geometry window, make sure that Area is selected in the Property dropdown, and that
Square Meters [sq. m] is selected in the Units dropdown. Note that you need to use a
Projected Coordinate System (PCS) in order for Calculate Geometry to work. Using a
Geographic Coordinate System (GCS) will disable this function. If you don’t have a PCS
available, open Properties for Layers and select an appropriate PCS.



o
Click OK. The Area field in the Attribute Table will now be populated with area
measurements in square meters.



o
Add another field. Name it AreaWeight. Type: Float. Precision: 6. Scale: 4.
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o
Click OK

o
Right click on the Area field. Then click Statistics. Find the Sum and copy that number
by highlighting it and then right clicking and click Copy, or highlight and then hit Ctrl+C
on your keyboard.

o
Exit out of this window.

o
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Right click on AreaWeight. Click Field Calculator. In the Field Calculator window,
double click on Area in the Fields box. Then click the “/” button. Then paste the area sum
number by right-clicking and clicking Paste, or by hitting Ctrl+V on the keyboard.
The formula is AreaWeight = Area / total area



o
Click OK



o
Add another field. Name: PMWeight. Type: Float. Precision: 6. Scale: 4.



o
Click OK
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o
Right click on the PMWeight column. Click Field Calculator. Enter the formula:
PM_Weight = [Area_Weigh] * PM concentration. Use MAXLEVEL for PM
concentration because we are most concerned about where it is the worst.



o
Click OK



o
Add another Field. Name: AvgPM. Type: Float. Precision: 6. Scale: 4.
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o
Click OK



o
Find the Sum of the PMWeight field. This is the average PM concentration for that
CMAQ grid. Right click PMWeight. Select Statistics. Copy the Sum.



o
Exit out of the Statistics window then Right click on AvgPM. Click Field Calculator. In
the box paste the Sum from the previous step.
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o
Click OK



o
Repeat these steps for the rest of the clipped AERMOD shapefiles.

A.2.1.3 Merge clipped AERMOD shapefiles
 Click on Geoprocessing in the menu bar. Then click Merge to open the Merge tool.

o
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Click the File button next to the Input Datasets dropdown. Navigate to the
AERMOD_Clips folder in the PA2007 folder and select all of the shapefiles. Then click
Add. Otherwise you have to select them one at a time from the dropdown menu. To save
the output file, navigate to the PA2007 folder and name the new file:
PA2007_AERMOD_ClipMerge.



o
Click OK.



o
Change Symbology (optional). Right click on the new shapefile. Click Properties, then go
to the Symbology tab. Change symbology accordingly.
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o
Click OK

o

A.2.1.4 Create Average PM shapefile with Spatial Join
 Use the Add Data tool to add CMAQPittsburgh_Baseline
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o
Spatial Join - Go to ArcToolbox, then Analysis tools, then Overlay, then double click on
Spatial Join

o
Select CMAQPittsburgh_Baseline as the Target Features. Select
PA2007_AERMOD_ClipMerge as the Join Features. For the Output Feature Class,
navigate to the PA2007 folder, and name the new file PA2007_AvgPM. Make sure the
Match Option is set to Contains.
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o
Delete all Join Features from PA2007_AERMOD_ClipMerge by highlighting one and
then clicking the X button. The Join Features that should remain are: COL, ROW,
D24HourMean, YearlyAvg, and AvgPM.
Make sure the Match Option dropdown is set to CONTAINS.



o
Click OK
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o
(Optional) Change Symbology



o
Click OK

o
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A.2.2 Create the Control
A.2.2.1 Create Shapefile for Control by exporting PA2007_AvgPM to a new shapefile
 This step is mainly so we can have individual shapefiles for the average PM data and for
the Control values in case they are both needed for maps later.
 Right click on PA2007_AvgPM. Then click on Data -> Export to bring up the Export
Data window. Click the File button and navigate to the PA2007 folder. Name the new file
PA2007_Control.



o
Click OK



o
Click Yes

o
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A.2.2.2 Subtract truck emissions from the baseline
 Open the Attribute Table for PA2007_Control



o
Add a field. Name it “Ctrl_PM.” Type: Float. Precision: 6. Scale: 4.



o
Click OK



o
Right click on the heading of Ctrl_PM and select Field Calculator to bring up the field
calculator window. Double click on the YearlyAvg field (or D24HourMean, they are the
same), then click on the “-“ button, then double click on the Avg_PM field. So that the
equation is Ctrl_PM = [YearlyAvg] – [Avg_PM].
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o
Click OK



o
Close out of the Attribute Table and change the symbology for PA2007_Control
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o

o

A.2.2.3 Export Table
 Click on the Table Options button in the Attribute Table of PA2007_Control. Click on
Export to open the Export Data window. Click on the File button and navigate to the
PA2007 folder. Change the file type to Text File. Name the new file
PA2007_Control.csv. Make sure to add the .CSV extension.
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o
Click Save



o
Click OK




o
Click No.
Close out of the Attribute Table. Then Save the project.

A.2.2.4 Excel – Edit PA2007_Control.csv file
 Open the PA2007_Control.csv file in Excel
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o
Delete all columns EXCEPT COL, ROW, and Ctrl_PM



o
Add the Metric, Seasonal Metric, and Annual Metric columns. Change the Ctrl_PM
column name to Values.
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o
Save and close.

A.3 BenMAP-CE
A.3.1 Set up new project
A.3.1.1 Create New Setup
 Open BenMAP-CE then click on the Modify Datasets button in the menu bar



o
Click on Add to create a new Setup. Name it PA2007.
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o
Click OK

o
A.3.1.2 Add Grid Definition
 Click the Manage button under the Grid Definitions window
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o
Click the Add button to bring up the Grid Definition window



o
Click on the File button next to Load Shapefile. Navigate to the Pittsburgh folder. Select
and open CMAQGrid_Pittsburgh.
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o
In the Grid ID box at the top, type CMAQGrid_Pittsburgh. Then make sure that the Grid
Type dropdown has Shapefile Grid selected.



o
Click OK. CMAQGrid_Pittsburgh will now show up in the Manage Grid Definitions
window.
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o
Click OK. CMAQGrid_Pittsburgh will now show up in the Grid Definitions window.



o
Click OK and return to the main window.

A.3.1.3 Import Datasets
 The following Datasets are necessary for this model:
o Health Impact Functions
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 EPA Standard Health Functions
 PM NAAQS 2012 Additional Functions
o Incidence/Prevalence Rates
 Mortality Incidence (2010)
 Other Incidence (2007)
o Income Growth Adjustments
 EPA Standard Income Growth
o Inflation Datasets
 EPA Standard Inflators
o Pollutant (in Marcellus folder)
 PM2.5
o Valuation Functions
 EPA Standard Valuation Functions
o Variable Datasets
 EPA Standard Variables
On the main BenMAP-CE window, click on the Tools dropdown in the menu bar. Then
click Database Import.

o
Click on the File button and navigate to the BenMAPCE_Data folder, then the Datasets
folder, then the Health Functions folder, and select EPA Standard Health Functions.
Click Open.
Then in the Target Setup dropdown, select PA2007.

o
Click OK. It may take a few minutes to load, depending on the dataset. Once it is done,
the File imported window will pop up.
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o
Click OK to be returned to the Database Import window




o
Repeat the previous steps for the rest of the datasets.
Once everything has been imported, click Cancel to return to the main BenMAP-CE
screen. Go to Modify Datasets and choose PA2007 in the Setups dropdown.

o
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The County Grid Definition, and the Ozone Pollutants datasets are tied to and brought in
by other datasets when they are imported.

A.3.1.4 Load Population
 Click the Manage button under the Population Datasets box in the Modify Datasets
window. Make sure the PA2007 Setup is selected.



o
Click Add to load population dataset



o
CMAQGrid_Pittsburgh in the Grid Definition dropdown. Choose United States Census in
the Population Configuration dropdown.
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o
Click the Browse button next to the Database box. Navigate to the Results folder within
the PopGrid folder. Select Pittsburgh_2010_POP



o
Click Open.
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o
Click Validate



o
Click OK. Then click the check box next to Use Population Growth Weights
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o
Click the Browse button next to the Use Population Growth Weights box. Select
Pittsburgh_2010_popwgt



o
Click Open. Make sure everything is correct and that the Population dataset name is
Pittsburgh.
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o
Click OK. You’ll be returned to the Manage Population Datasets window where it will
now display information about the Pittsburgh population dataset.



o
Click OK. “Pittsburgh” will now be listed in the Population Datasets box.
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o
Click OK to return to the main window.

A.3.1.5 Save project
 Go to the main screen



o
Click the dropdown next to Unites States and change it to PA2007.
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o
Click on File, then Save As(*.projx). Navigate to the BenMAPCE_Data folder and save it
as PA2007.projx.



o
Click Save.



o
Click OK, and you’ll be returned to the main screen.

A.3.2 Run BenMAP-CE model
A.3.2.1 Air Quality Surfaces
A.3.2.1.1 Pollutant
 Go to the main screen. Make sure the current setup is PA2007
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o
Go to the menu on the left and double click on Pollutant



o
Click, and drag PM2.5 to the Selected Pollutants box



o
Click OK. You’ll be returned to the main screen. Now the bubble in front of Pollutant
will be green.
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o

A.3.2.1.2 Baseline
 Double click on Baseline in the left menu



o
Make sure CMAQGrid_Pittsburgh and Model Data are selected. Click Next.
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o
Click on the File button next to the Model Database box. Navigate to the Pittsburgh
folder and select CMAQPittsburgh_Baseline.



o
Click Open.
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o
Click the Validate button.



o
Click OK. This will take you to a Save As file window. Navigate to the BenMAP_Data
folder. Then create a new folder named AQG. Name the file CMAQPittsburgh_Baseline.
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o
Click Save. You’ll be returned to the main screen where the bubble in front of Baseline
will now be green.



o
Double click on the small map icon under Baseline. This will draw
CMAQPittsburgh_Baseline.
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o

A.3.2.1.3 Control
 Double click on Control in the left hand menu.



o
Make sure Grid Type has CMAQGrid_Pittsburgh selected, and Model Data is selected.
Click Next.
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o
Click on the File button and navigate to the PA2007 folder and select PA2007_Control.
(BenMAP-CE was giving me errors when validating this file, even though everything
was correct. So I opened PA2007_Control in Excel, then saved as PA2007_Control.CSV.
This changed it to an xlsx file, as seen in the file type dropdown)

o
Click Open.
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o
Click Validate



o
Click OK. The Save As window will come up. Navigate to the AQG folder and save as
PA2007_Control.

o
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Click Save. You’ll be returned to the main window. The bubble in front of Control will
now be green.



o
Double click on the map icon under Control. This will draw the map for
PA2007_Control.



o
Double click on Air Quality Delta in the left menu
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o

A.3.2.2 Estimate Health Impacts
A.3.2.2.1 Population Dataset
 In the main BenMAP-CE window, double click on Population in the menu on the left.



o
Make sure the Population Dataset is Pittsburgh, and the Population Year is 2010. Click
OK

o
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A.3.2.2.2 Health Impact Functions
 In the main BenMAP-CE window, double click on Health Impact Functions in the menu
on the left.





o
Make sure the Filter Dataset dropdown is set to EPA Standard Health Functions. Change
the Filter Endpoint Group to Mortality.

o
Select Mortality, All Cause with Author and Year combinations: Woodruff 1997, and
Krewski 2009. Select multiple entries by holding down the Ctrl key. Click, hold, and drag
selections to the bottom window.
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o
Change the Filter Endpoint Group to Hospital Admissions, Respiratory. Find and Select
“HA, Chronic Lung Disease (less asthma)” by Moolgavkar 2000, and make sure the age
range is 18-64. Click and drag it to the bottom window. Make sure the whole bottom
window has a blue outline before dropping, otherwise it will be dropped as a sub entry
under another.

o
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o
Make sure the Incidence Dataset for this function is set to Other Incidence (2007)

o
Find and select the Endpoint “HA, Asthma” by Sheppard and click and drag it into the
bottom pane. Click on the start age and change it from 0 to 18 so that it will match the
age range of the Moolgavkar function, because they will be pooled later.
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o
Change the Filter Endpoint Group to Hospital Admissions, Cardiovascular. Find the
Endpoint “HA, All Cardiovascular (less Myocardial Infarction)” by Moolgavkar, 2000,
Age range 18-64. Drag it to the bottom pane. Make sure its Incidence Dataset is also set
to Other Incidence (2007).

o
Change the Filter Dataset to PM NAAQS Final 2012 Additional Functions. Change the
Filter Endpoint Group to Mortality. There will be one entry with the author Lepeule.
Click, drag, and drop it into the bottom window.
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o
Click Run.




o
Click Yes. The Save As window will appear.
Navigate to the BenMAPCE_Data folder, then create a new folder named “cfgrx.” Name
the file PA2007_HIF (for Health Impact Function).



o
Click Save. You’ll be returned to the Health Impact Functions window. It will now be
loading population data and running the functions. If it says (Not Responding) just let it
do its thing.
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o
Once it is complete, you’ll be returned to the main screen.



o
The Health impact functions bubble on the left should now be green, and the functions
themselves now appear in the top window.

A.3.2.3 Aggregate, Pool & Value
A.3.2.3.1 Aggregation
 Double click on Aggregation in the left-side menu on the main BenMAP-CE screen.
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o
Select CMAQGrid_Pittsburgh for both dropdowns



o
Click OK. You’ll return to the main screen and the Aggregation bubble should now be
green.

o

A.3.2.3.2 Pooling Method and Valuation
 Double click on Pooling Method in the left menu on the main BenMAP-CE screen.
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o
Health functions can be pooled together so that each has a certain weight compared to the
other functions in that same pool. The Hospital Admissions: Respiratory functions will be
pooled, but the rest will not. Functions that are not pooled with other functions still need
their own Pooling Window.
Change the Pooling Window Name to Mortality Krewski. Then click, hold, and drag the
blue box with Krewski in it and drop it in the bottom pane.

o
Click Add to make a new pooling window. Name it Infant Mortality Woodruff. Drag and
drop the blue box with Woodruff into the bottom pane.
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o
Click Add to make a new pooling window. Name it Mortality Lepeule. Drag and drop the
blue box with Lepeule into the bottom pane.



o
Click Add to make a new pooling window. Name it HA Respiratory. Drag and drop “HA,
Chronic Lung Disease (less asthma)” and “HA, Asthma” to the bottom pane
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o
Click on “None” under Pooling Methods. Choose “Sum Independent” from the dropdown
menu.



o
Click Add to add a new pooling window and name it HA Cardiovascular. Then drag and
drop “HA, All Cardiovascular (less myocardial infarctions).

208





o
Click Next.

o
Scroll the Valuation Methods window over until you can see the distributions (column
name is DistA). Select the Weibull distribution and drag and drop it directly under
Mortality in the window on the right. Make sure the blue line is under Mortality before
you drop the valuation function.
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o



o
Use the same Weibull function for Infant Mortality Woodruff, and Mortality Lepeule.
Click on their respective tabs and then drag and drop the Weibull function under
Mortality.
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o



o
Click on the HA Respiratory tab. The valuation methods window will change because
we’re looking at a different type of health endpoint. Choose the Valuation Functions with
End Points: “HA, Chronic Lung Disease (less asthma)” with age range 18 – 64, and “HA,
Asthma” with age range 0 – 64 and drag them both under Hospital Admissions,
Respiratory.
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o



o
Click on “None” under Pooling Method and choose Sum Independent.

o
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Click on the HA Cardiovascular tab. Then choose the Valuation Function with End Point
“HA, All Cardiovascular” with age range 18-64, and put it under Hospital Admissions,
Cardiovascular.



o
In the Variable Dataset Dropdown, choose EPA Standard Variables.



o
Click on the “Advanced” button to bring up the Advanced Pooling Settings window.
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o
This first tab deals with the weighting of pooled functions.
Click on the Currency Year and Income Growth tab

o
The valuation functions come with a currency year. This tab adjusts those functions for
inflation and income growth. Set both to 2010. Then click OK to return to the previous
screen.
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o
Click the Run As (*.apvrx) button.



o
Click Yes. In the Save As window, navigate to the BenMAP-CE folder. Create a new
folder named apvrx. In that folder, save the file as PA2007_Valuation.



o
Click Save
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o
Click OK. The pooling and valuation windows close and you’re returned to the main
BenMAP-CE screen. All of the bubbles on the left will now be green, and the run is
complete.

o
File – Save the project.

A.3.3 Generate Reports
A.3.3.1 Health Impact Results
 In the main BenMAP-CE screen, click on the (2) Health Impact Results tab across the
top. It should already be selected and the health impact functions should be displayed in
the small window beneath it.
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o
Double click on the Krewski Health Impact Function. It will draw in the map below.
Collapse and turn off the PM2.5 layers so that the Krewski results can be seen.



o
Double click on each of the other functions to draw them as well.

217

o

o
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o
Above the Map view, click on the Data tab to look at the raw data

o
The raw data can be exported by clicking on the “Output” button in the bottom right of
the screen. It will export as a .csv and can be opened in Excel. Can use this to calculate
the total population in a function’s age range.
Click on the Chart tab to view the chart. It happens to include all of the counties across
the entire USA, so you’d have to search for and select the correct ones.
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o
If you click on the Audit Trail Report tab next to the Chart tab, you will see that it is
blank. This is because we haven’t done the Audit Trail Report yet.

A.3.3.2 Pooled Incidence Results
 In the main BenMAP-CE window, click on the (3) Pooled Incidence Results tab across
the top, and the GIS Map tab in the middle.



o
The pooled Health Impact Functions are found here in the small upper window with all
the Health Impact Functions. Some are the standard single functions that are the same as
those on the (2) Health Impact Results tab.
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A.3.3.3 Pooled Valuation Results
 On the main BenMAP-CE screen, click on the (3) Pooled Valuation Results tab at the
top. Double click on each of the functions to draw them on the map. Each will have its
own legend on the side. The maps will stack on top of each other.

o

A.3.3.4 Audit Trail Report
 On the main BenMAP-CE window, click on the Audit Trail Report tab along the top.



o
Select Current Audit Trail Report. Then click OK
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o
Review the Audit Trail Report to ensure that the air quality grids, population data, health
incidence data, health impact functions, and valuation estimates appear as expected.
Click the Output button to save. Navigate to the PA2007 folder. Save the file as
PA2007_AuditTrailReport.



o
Click Save



o
Click OK.
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The Audit Trail Report will now populate in the respective tab in the middle of the screen



o
File – Save the project.

A.3.4 Export Data
A.3.4.1 Export Shapefiles
 Go to the main BenMAP-CE screen. Click on the GIS Map tab.



o
To export the shapefiles of the results, right click on the layer you want to export. In this
case, Lepeule. In the popup menu hover over Data, then click Export Data.
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o
Keep All Features selected in the Export dropdown. Click on the File button. Navigate to
the PA2007 folder. Name the file PA2007_Lepeule_HealthImpact.



o
Click Save.



o
Click OK.




o
Click No.
Repeat for all other shapefiles you want to export.
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A.3.4.2 Export Raw Data
 Go to the main BenMAP-CE screen. Click on the Data tab. Then double click on the
Health Impact Function or the Valuation Results you want to export. In this case, the
Health Impact Results for Krewski.





o
Click on the Output button in the bottom right, which brings up a Save As window.
Navigate to the PA2007 folder. Create a folder called CSV_Files. Save the file as
PA2007_Krewski_HealthImpact.

o
Click Save
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o
Click OK.
Repeat for other desired raw data.

A.3.5 Opening a Saved Project
 Open BenMAP-CE. Go to File -> Open Project. Navigate to and open PA2007.




o
You will notice that none of the maps are drawn, that the top window does not have
Health Impact or Valuation results, and that some of the bubbles on the left are red.
To draw the Air quality surfaces, just double click on them like normal.
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o
Double click on the (2) Estimate Health Impacts heading in the menu on the left. It will
open the Open Existing Configuration window.



o
Click on the lower File button, the one next to the “Or Open Existing Configuration
Result File (*cfgrx)” box. Navigate to the cfgrx folder and select PA2007_HIF



o
Click Open.
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o
Click the OK button in the bottom right.

o
The bubbles have changed color and the Health Impact results have now populated in the
upper window.
You can now double click on the Health Impact results to draw them

o
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Double click on the (3) Aggregate, Pool & Value heading on the left.



o
Click on the lower File button next to “Or Open Existing APV Result File (*.apvrx).”
Navigate to the apvrx folder and select PA2007_Valuation.apvrx.



o
Click Open.



o
Click the OK button on the lower right.
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o
All the bubbles have turned green and the run is complete.
Go to the (3) Pooled Valuation Results tab on the top and double click on one of the
functions to draw it.

o

A.4 File Locations


ArcGIS ->
o BenMAP_Shapefiles
 12kmCMAQGrid_Nation (shapefile exported from BenMAP)
 CountiesNation (shapefile exported from BenMAP)
o Default.gdb (default geodatabase for ArcMap)
o Marcellus
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 CMAQ grid and States shapefiles in the Marcellus Shale region
 MarcellusCMAQ_Baseline
o PA2007
 AERMOD_Clips
 AERMOD files clipped to CMAQ grid
 PA2007_AERMOD_ClipMerge
 PA2007_AvgPM
 PA2007_Control
 PA2007_AuditTrailReport.txt
o PA2007 -> CSV_Files
 PA2007_Lepeule_HealthImpact (and other raw data results)
o Pittsburgh
 CMAQGrid_Pittsburgh (NAD83 – MAIN CMAQ Grid)
 CMAQGrid_Pittsburgh18N (UTM18N projection)
 CMAQPittsburgh_Baseline (Monitoring emissions baseline of Marcellus
clipped to Pittsburgh CMAQ grid)
BenMAPCE_Data ->
o Datasets
 Health Impact Functions, etc.
o AQG
 MarcellusCMAQ_Baseline (air quality grid)
 CMAQPittsburgh_Baseline
 PA2007_Control
o Apvrx
 PA2007_Valuation
o Cfgrx
 PA2007_HIF
o PopGrid v4.3 - Census 2010
 Results
 Pittsburgh_2010_POP.csv
 Pittsburgh_2010_POP_popwgt.csv
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